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  Caution 
For use with UL Listed, CSA and GS approved personal computers. 

Not intended for use in machinery, medical or industrial applications. 

Do not use onboard an aircraft or in hazardous locations such as a gas station or other explosive 
environment. 

For indoor use only. 

Do not touch or re-orient the antenna while the device is transmitting 

Device should be located at least 5 cm (2 inches) away from any human body in order to meet FCC 
exposure limits.  Exposure time should be limited if the distance is less. 

  Avertissement 
N’utilisez qu’avec des composantes homologuées UL, CSA ou TUV. 

Ne pas utiliser ce dispositif dans une application industrielle ou médicale. 

Ne pas utiliser dans un avion ou en présence de vapeur explosive (station-service). 

N’utiliser qu’à l’intérieur. 

Ne touchez pas à l’antenne lorsque l’appareil est en fonction 

Autre composantes: Ce dispositif doit être à plus de 5 cm (2 pouces) de toute personne sinon l’utilisateur 
devrait limiter le temps d’exposition. 
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My Network Settings 
Use this page to record your network settings.  

Workgroup or domain name: ______________________________________  

Base Station password:  __________________________________________  
   (Default=admin) 

Wireless Settings 
Record the information used to configure a computer for wireless access to your 
network here. All computers accessing your network with a wireless connection 
need to use the same wireless settings. 

Wireless network name (SSID): ____________________________________  

WEP key or WPA passphrase: ______________________________________  

Wireless channel (ad-hoc networks only): ____________________________  

Wide Area Network Settings 
Complete this section only if your network has a base station (gateway or router). 
You can obtain this information from your Internet service provider (ISP). Your ISP 
may not require all of the settings listed below. 

Dynamic IP (DHCP) Settings 
Complete this section only if your ISP uses a DHCP connection. 

Host name: _____________________________________________________  

Adapter MAC address: ____________________________________________  

Static IP Address Settings 
Complete this section only if your ISP has assigned you a specific IP address. 

Static IP address: ________________________________________________  

Subnet mask: ___________________________________________________  

IP gateway address: ______________________________________________  

Primary DNS server: ______________________________________________  

Secondary DNS server: ___________________________________________  

PPPoE Settings  
Complete this section only if your ISP uses PPPoE. 

User name: _____________________________________________________  

Password: ______________________________________________________  

Service name: ___________________________________________________  
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introduction 
Welcome to Wireless-G 
Thank you for purchasing the Microsoft® Broadband Networking Wireless PCI Adapter. 
This wireless adapter is up to five times faster than 802.11b adapters. You can use 
your adapter to add a computer to a new or existing wireless network. This chapter 
describes your wireless adapter and explains wireless (radio) connections.  

 Note   For more information about 802.11g, see “Understanding Wireless Transmission 
Standards” later in this chapter. 

About Your Wireless PCI Adapter 
Your wireless adapter comes with a Setup CD, User’s Guide, and Start Here guide, as 
shown in the following illustration. 
 

User's Guide and 
Start Here Guide

Setup CD
Install This First!

Wireless PCI Adapter
(MN-730)  

 

The Microsoft Wireless PCI adapter is installed in a PCI slot inside your computer, and 
is secured by a metal mounting bracket and screw. The following illustration shows the 
location of the status light and antenna on the adapter. 
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Antenna

Mounting bracket

Wireless light

 
 

The Wireless status light provides information about network connectivity and data 
activity. The following table describes the behavior of the Wireless light. 
 

When the light is… This means… 

On The adapter has established communication with a wireless network. 

Blinking quickly Data is being sent or received wirelessly. 

Blinking slowly The adapter is trying to establish communication with a wireless network. 

Off The adapter is not receiving power, is not recognized by Microsoft 
Windows®, or is disabled. 
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About Wireless (Radio) Connections 
Your adapter communicates by radio transmission. Radio waves travel in all directions, 
and can be transmitted through walls and floors. This section on wireless connections 
explains wireless network types and provides important information about wireless 
performance. 

Types of Wireless Networks 
There are two types of wireless networks: infrastructure and ad hoc. 

In an infrastructure network, a wireless adapter connects to a wireless network 
through a central wireless access point, gateway, or router, such as a Microsoft 
Wireless Base Station. This type of network is often used when a broadband Internet 
connection will be shared among computers, or when there are more than two 
computers or devices on a wireless network. The following illustration shows an 
infrastructure network. 
 

 
 

Download from Www.Somanuals.com. All Manuals Search And Download.



4     Microsoft Broadband Networking Wireless PCI Adapter User’s Guide 

 

 

In an ad hoc network, a wireless adapter connects directly to wireless adapters that 
are installed in other computers. This type of network is often used when only two 
computers or devices are being connected, when a broadband Internet connection will 
not be shared, or when the connection to another computer is intended to be 
temporary. The following illustration shows an ad hoc network. 
 

First computer Second computer 
 

You can use the same adapter to join different wireless networks (and different types 
of wireless networks) at different times. For example, you might use your adapter to 
connect to an infrastructure network at home most of the time, but occasionally, you 
might use your adapter to set up a temporary ad hoc network to share files with a 
colleague who visits you at your home office. 

The Microsoft wireless PCI adapter is very versatile. You can use it to join a network 
that has a non-Microsoft router, gateway, or wireless access point. You can also 
establish ad hoc connections to non-Microsoft adapters. When joining these types of 
networks, you might need to choose or enter some wireless network settings manually. 

Placement of Wireless Components 
The following placement recommendations will help you achieve the best wireless 
range, coverage, security, and connection speed from your wireless devices: 

O Place wireless components in direct line of sight to one another, if possible.  

O Place wireless components on desks or shelves when possible (instead of on the 
floor) to avoid obstacles and achieve better reception on the upper stories of 
buildings.  

O Avoid placing wireless components in a way such that large, solid objects block the 
direct path between them. Building components, such as fireplaces, concrete or 
masonry walls and floors, metal framing, UV window film, and metallic paint will 
reduce radio signal strength.  

Note   Radio waves will travel around your computer case when you send and receive 
data wirelessly by using your PCI adapter. Make sure to place your computer a 
reasonable distance away from other large metal objects or building materials.  

O Avoid placing wireless components close to electromagnetic devices, especially 
those with frequencies in the 2.4-gigahertz (GHz) range. Devices such as cordless 
phones, microwave ovens, radios, and televisions can interfere with wireless 
transmission.  

O If you notice poor connection speed in an area, try moving your wireless 
components closer together. Connection speeds will be slower if your wireless 
components are very far apart from each other on the network. 

O Be aware that wireless signal range, speed, and strength can be affected by 
interference from neighboring wireless networks and devices.  
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Adjusting the Antenna 
To improve wireless reception, you can adjust the adapter’s antenna. Start with the 
antenna pointing straight up, and adjust the antenna if you experience poor signal 
strength. Certain areas, such as directly below the antenna, get relatively poor 
reception. Pointing the antenna toward another wireless component does not improve 
reception.  

Understanding Wireless Transmission Standards 
802.11 is a series of wireless transmission standards developed by the Institute of 
Electrical and Electronics Engineers (IEEE) for wireless local area networks. Currently, 
four specifications make up the 802.11 series: 802.11, 802.11a, 802.11b, and 
802.11g. Your Microsoft Wireless PCI Adapter conforms to the latest specification, 
802.11g. The main features that distinguish these specifications are connection 
speed and radio frequency.  

The following table summarizes the four specifications in the 802.11 series. 
 

Specification Connection speed Radio frequency band 

802.11 1 or 2 megabits per second (Mbps) 2.4 GHz 

802.11a Up to 54 Mbps 5 GHz 

802.11b 5.5 and 11 Mbps 2.4 GHz 

802.11g Up to 54 Mbps 2.4 GHz 
 

    Note   The benefit of the 2.4-GHz radio frequency band is that it allows for greater range 
than the 5-GHz band. The drawback is that it is susceptible to interference from other 
devices, such as 2.4-GHz cordless telephones.  

Because 802.11b and 802.11g use the same radio frequency, your 802.11g adapter 
is compatible with 802.11b devices. However, when you transfer data between 
802.11b and 802.11g devices, the connection speed is limited to the 802.11b 
maximum of 11 Mbps.  

   Note   Your Microsoft Wireless adapter is not compatible with 802.11a-only devices. 
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setup 
Using the Setup Wizard  
This chapter will guide you through the setup process for your Microsoft® Broadband 
Networking Wireless PCI Adapter. To set up your adapter, you need a computer that: 

O Is running Microsoft Windows® XP, Windows Millennium Edition, Windows 2000 
Professional, Windows 98, or Windows 98 SE operating system. 

O Has an available PCI card slot. 

The steps in this chapter correspond to the steps that you will go through in the wizard 
on the Setup CD.  

 Note   If you don’t want to use the Setup Wizard to set up your adapter, and you have 
Windows XP, it is possible to set up your adapter by using the Add Hardware Wizard and 
the Wireless Network Connection utility in Windows. However, using the Setup Wizard is 
recommended because the Setup Wizard installs the network utility software and 
configures your wireless network settings.  

Step 1: Gather Components, Tools, and Information 
1. Take the following items to your computer: 

O Setup and Network Utility CD 

O Microsoft Wireless PCI Adapter 

O This User’s Guide  

O Documentation from your computer’s manufacturer 

O Phillips screwdriver 

O The floppy disk, file, printout, or written record of network settings that you 
created when setting up your network. (If you don’t have a saved copy of your 
network settings, see Appendix A, “Determining Your Network Settings.”) 

O Installation CD for your Windows operating system if your computer is running 
Windows Me, Windows 98, or Windows 98 SE 

Note   You can use the Setup and Network Utility CD (v.2.0) that comes with this 
adapter to install all current and previous versions of Microsoft Broadband Networking 
products. If you have other Microsoft Broadband Networking products on your network, 
you do not need to keep multiple copies of this CD and you can discard earlier versions 
of this CD. 

2. If your computer is running Windows XP or Windows 2000, log on as a member of 
the Administrator group. If you are not logged on as an administrator, click Start, 
click Log Off, and then press CTRL+ALT+DELETE. Log on again with an 
administrator’s name and password. 

2 
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3. If you are setting up an adapter on a computer that is already connected to a 
network over Ethernet, disconnect the computer from the network.  

Note   After you set up the wireless adapter, you can still return to using the Ethernet 
connection (instead of the wireless connection) at times if you want to. For some tasks 
that you might perform on your network, using an Ethernet connection may increase 
the data transfer rate. However, if you switch to an Ethernet connection, you will 
typically not notice an increase in speed when you access the Internet over your 
broadband connection.   

 

Step 2: Run the Setup Wizard 
1. Insert the Setup CD into your CD drive. If the Setup Wizard does not start 

automatically after a few seconds, open My Computer, double-click the CD icon, 
and then double-click Setup or Setup.exe. 

Note   During setup, you may be prompted to restart your computer or insert your 
Windows operating system CD. You may also need to specify the location of the 
required setup files on the Windows CD. Do this by typing the drive letter of your CD 
drive and the appropriate directory (for example, D:\win98). 

2. On the first screen that appears, click Set Up a Product. 

The wizard will detect any components that are missing on your computer and 
specify which of these components are required for setup and which are optional.  

3. Continue following the instructions in the wizard to install missing components (as 
necessary). 

4. When the wizard asks whether you are setting up a base station or an adapter, click 
Network adapter. 

5. When the wizard asks which network adapter you are setting up, click Wireless-G 
PCI Adapter (MN-730).  

6. Continue following the instructions in the Setup Wizard. If you have a question, click 
a Help link on the screen for more information.  

If you need to cancel setup before it is complete, you can rerun the wizard. When 
the Setup Wizard restarts, click Set Up a Product. 

7. When the wizard prompts you to install the PCI adapter on your computer, click 
Next and then shut down your computer.  
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Step 3: Install the Adapter in Your Computer 
1. After your computer shuts down completely, unplug the power cord from the back 

of the computer to prevent electric shock. 

2. Remove the cover from your computer. For instructions, see your computer 
documentation. 

Caution   Electronic components are sensitive to static electricity. Always ground 
yourself by touching the metal frame of your computer with your bare hand before 
touching the PCI adapter or any other internal components of your computer. 

3. Locate an available PCI slot on your computer’s motherboard. 

Caution   Before you attempt to insert your PCI adapter into the PCI slot, make sure 
that the pin configuration of the slot matches that of the connectors on the bottom of 
the adapter.  

4. Remove the protective bracket from the PCI slot. 

5. Insert the wireless PCI adapter into the slot, as shown in the following illustration. 
Be careful to line up the connectors on the adapter with the PCI slot, and then press 
evenly on the top of the card until it is securely connected to the motherboard. 
When the adapter is correctly seated, the mounting bracket will be flush with the 
frame of the computer.  

 
Computer frame 

Protective bracket

Screw

Wireless PCI
Adapter

Mounting 
bracket

PCI slot

 
 

6. Screw the bracket of the wireless PCI adapter securely to your computer’s frame. 

7. Replace the cover on your computer. 
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8. Adjust the antenna so that it points upward and away from any adjacent cabling, as 
shown in the following illustration. Make sure that the antenna is screwed in snugly, 
being careful not to overtighten it.  

 

 
 

9. Plug in the power cord, and make sure that no other cables have come loose during 
installation. 

 

Step 4: Configure the Adapter 
1. Turn on your computer. 

When Windows starts, the Setup Wizard automatically resumes. 

Note   If you originally logged on as an administrator to begin Setup, make sure that 
you log on by using the same account after you restart your computer. 

2. Continue following the instructions in the Setup Wizard.  

3. When the wizard asks what type of network you have, select the option that best 
describes the network that you want to join. 

Important   If you want to share a broadband Internet connection on your network, it is 
recommended that you set up a network that uses a base station, gateway, or router. If 
you choose not to set up a base station on your network, you should set up security 
features on the computer that is sharing the Internet connection. If you have 
Windows XP, you can use Internet Connection Firewall to help provide such security. If 
you don’t have Windows XP, be sure to use other measures to help provide a security 
layer between your network and the Internet. For more information about security, see 
“Making Your Network More Secure” in Chapter 4. 
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4. If you are connecting to a network with a base station, gateway, or router, the 
wizard will prompt you for your wireless network settings. If you want to join an ad-
hoc network, see “Joining an Available Wireless Network” in Chapter 3.  

Note   For more information about network types, see “Types of Wireless Networks” in 
Chapter 1. 

5. The wizard will help you set up your computer for file and printer sharing. 

6. When you reach the end of the Setup Wizard, click Finish to exit the wizard. The 
Broadband Network Utility starts automatically. 

7. Remove the Setup CD from your CD drive and the floppy disk (if used) from the 
floppy disk drive. Keep your network settings handy for setting up additional 
computers on your network. 

 

Step 5: Test Your Network Connections 
1. View the status of your network in the Broadband Network Utility. Make sure that 

the other computers on your network appear under Network Devices. For more 
information about using the Broadband Network Utility, see Chapter 3. 

2. If you are sharing an Internet connection on your network, test your Internet 
connection by opening your Web browser and visiting a Web site, such as 
www.microsoft.com. 
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network activities 
Sharing Resources and Joining Other Networks 
After setting up your wireless network, you can perform common network tasks, such 
as making files and printers available to other computers (a process called “sharing”), 
and then accessing these shared resources. You can also use the same Internet 
connection from multiple computers on your network.  

This chapter describes how to: 

O Log on to your network. 

O Use the same Internet connection from multiple computers on your network.  

O Start the Broadband Network Utility (to view shared resources, join other networks, 
and access Help to troubleshoot problems). 

O Share files and folders from one computer and then access them from other 
computers.  

O Share a printer that is connected to one computer and then print to it from other 
computers.  

O Make other peripheral devices available to computers on your network.  

O Read e-mail messages on your network. 

O Play games on your network and on the Internet. 

O Create a computer-to-computer (ad hoc) network. 

O Join an available wireless network. 
 

3 
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Logging on to Your Network 
After starting your computer, you must always log on to your network to access files, 
printers, and other resources that have been shared.  

If you have Microsoft® Windows® 98 or Windows Millennium Edition operating system, 
do not click Cancel during the logon process, even if you decide to leave your 
password blank. Type your user name, type your password (or leave it blank), and then 
click OK. 
 

Do not
click Cancel  

 

If you are already using Windows, and you haven’t yet logged on to your network, you 
can log off from Windows and then log back on. 

To log off and log back on to your network 

1. Click Start. 

2. Click Log Off. (If Log Off does not appear on your Start menu, click Shut Down, 
make sure that Log Off is selected in the drop-down box, and then click OK.) 

3. Log on to your network. 
 

After you log on to your network, you can perform certain network functions, such as 
opening shared files. 
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Using an Internet Connection over a Network 
If you have the Microsoft Broadband Networking Wireless Base Station and a 
broadband connection to the Internet, the other computers on your network can share 
the original Internet connection. Internet sharing is automatically configured by the 
Setup Wizard when you install the base station.  

If you do not have a base station, you can configure one of your computers to share its 
broadband or dial-up Internet connection, provided that the computer is running 
Microsoft Windows XP, Windows 2000, Windows Millennium Edition, or Windows 98 
Second Edition. These versions of Windows include a feature called Internet 
Connection Sharing, which allows multiple computers on a network to use the same 
Internet connection, even at the same time. For information about setting up Internet 
Connection Sharing, look up “Internet Connection Sharing” in Windows Help.  

    Important   Before you share an Internet connection, check with your Internet service 
provider about its policy regarding Internet connection sharing. 

If you use Internet Connection Sharing, you must leave the computer with the Internet 
connection turned on for the other computers on the network to access the Internet. 
You will continue to access the Internet from each computer the way you normally do, 
for example, by using your Web browser. To browse the Web, each computer must 
have a Web browser (such as Microsoft Internet Explorer) installed. 

Although you aren’t likely to notice a difference in speed, sharing a broadband Internet 
connection with other computers on your network makes the Internet connection 
slightly slower for each person. Sharing a dial-up Internet connection has a more 
noticeable impact on speed.  

    Important   If you use Internet Connection Sharing, you should take measures to provide a 
security layer between your network and the Internet. If the computer with the shared 
Internet connection is running Windows XP, you can use Internet Connection Firewall to 
help provide such security. If the computer with the shared Internet connection is running 
an earlier version of the Windows operating system, we recommend using security 
software on this computer. 

Using the Broadband Network Utility 
The Microsoft Broadband Network Utility is automatically installed on your computer 
when you run the Setup Wizard. You can use the Broadband Network Utility to view 
other computers on the network, access shared files on those computers, and join 
other wireless networks.  

The Help system in the Broadband Network Utility provides additional information 
about Microsoft Broadband Networking products, using the Broadband Network Utility, 
performing common tasks on your network, and troubleshooting network problems. 
The Help system, the Network Troubleshooter, and Web Help are all available on the 
Help menu.  

   Note   For information about using the Broadband Network Utility to change wireless 
settings or update software, see Chapter 4.  
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To start the Broadband Network Utility 
O Click Start, point to Programs, and then click Microsoft Broadband Network 

Utility. 
-or- 

O Double-click the Broadband Network Utility icon  in the notification area at the 
far right of the Windows taskbar. 

 

Information about 
your network

The Internet connection 
status of your computer

A list of other 
computers that 
are connected 
to your network

Information about 
your computer

 
 

The right pane of the Broadband Network Utility displays information about the 
computers connected to your network. This information automatically refreshes at 
regularly scheduled intervals. You can also manually refresh the list. 

   Note   To see the full computer name and Internet protocol (IP) address of a computer in 
the Network Devices list, hold the mouse pointer over the computer in the list. 

 

To refresh the Network Devices list 
O Right-click the icon for an active device, and then click Refresh. 

 

To remove an inactive device from the Network Devices list 
O Right-click the dimmed icon for the device, and then click Remove from List. 

 

In the sections that follow you will read about how to use the Broadband Network 
Utility to access shared files on network computers and to join other networks. 

Using Files and Folders over a Network 
This section explains how you can make files and folders available on one computer (a 
process called “file and folder sharing”) and then access those files and folders from 
other computers on your network.  

To make using files and folders over a network easy, you should assign all computers 
on your network to the same workgroup if you haven’t done so already. For information 
about how to do this, look up “workgroup” in Windows Help. 

    Important   Do not assign a computer (such as a work laptop) to your workgroup if  
the computer is already a member of a domain, and you intend to reconnect to the 
domain later. 
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Step 1: Make your files and folders available to the network 
You may have set up file sharing on your computers when you set up the base station 
and adapter. If you did not set up file sharing when you set up your hardware, you can 
enable it by using the Windows operating system. You can also use Windows to change 
or further refine the settings you selected during Setup. For more detailed instructions 
and information about sharing files and folders, see Windows Help.  

    Note   If you have Windows 2000 or Windows XP, you need to have sufficient privileges  
(or be the network administrator) to share folders with others. For more information, look 
up “administrator” in Windows Help. 

File and folder sharing is configured from the computer that contains the files and 
folders you wish to share. You can share an entire drive with the network, or you can 
share specific folders. For example, if you store photographs of your children in a 
folder named “Kids” on your computer, and you want to make the photographs 
available to your network, you can choose to share only the Kids folder.  

    Important   Although you can share files, printers, and other devices on your network, you 
cannot share software programs, such as Microsoft Word or Microsoft Excel.  

To share a folder or drive on your computer (in Windows XP) 

1. Enable file sharing on your computer if you have not already done so. You need to 
do this only once. For information about how to enable file sharing, see Windows 
Help. 

2. Open My Computer. 

3. Browse to the drive or folder that you want to make available to other computers on 
your network, and then select it. 

4. On the File menu, click Sharing and Security. 

5. Click Share this folder on the network. By default, the folder is made available to 
all of the other computers on your network, and everyone has read-only access. To 
give everyone read-write access, check the Allow Network Users to Change My 
Files check box. 

6. Click OK. 
 

To share a folder or drive on your computer (in Windows 2000) 

1. Enable file sharing on your computer if you have not already done so. You need to 
do this only once. For information about how to enable file sharing, see Windows 
Help. 

2. Open My Computer. 

3. Browse to the drive or folder that you want to make available to other computers on 
your network, and then select it. 

4. On the File menu, click Sharing. 

5. Click Share this folder. By default, the folder is made available to all of the other 
computers on your network, and everyone has read-write access. To change the 
access level, click Permissions. 

6. Click OK. 
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To share a folder or drive on your computer (in Windows 98, Windows 98 SE, and 
Windows Me) 

1. Enable file sharing on your computer if you have not already done so. You need to 
do this only once. For information about how to enable file sharing, see Windows 
Help. 

2. Open My Computer. 

3. Select the file or folder that you want to make available to other computers on your 
network. 

4. On the File menu, click Sharing. 

5. Click Shared as. Change the level of access if you want, and then click OK. 
 

Only the computer users on your network will have access to the files you share. At 
times, you may want to prevent certain users, such as your children, from accessing 
particular folders and the files they contain. If you want to increase the security of your 
shared files, you can assign permissions and passwords to your files and folders. For 
more information, look up “permission” and “access control” in Windows Help. (In 
Windows Millennium Edition, look up “controlling access.”) 

    Note   For a computer’s files and folders to be available to the network, the computer must 
be turned on and logged on to the network. Also, if the computer is turned on but in sleep 
mode, it will not be accessible from the network. For more information, look up “power 
options” in Windows XP Help, or “power management” in Windows Me, Windows 2000, 
and Windows 98 Help. 

Step 2: Access shared files 
To access shared files and folders, you can use the Broadband Network Utility and  
My Computer.  

    Note   If you want to work with shared files on a computer that does not have the 
Broadband Network Utility installed, you can use Network Neighborhood or My Network 
Places in Windows instead. For more information, see Windows Help. 

To access shared files on other computers 

1. Start the Broadband Network Utility. 

2. In the Network Devices list, double-click the computer that stores the file you want 
to access. 

3. Use the window that appears to browse the shared folders on that computer and 
locate the file. 

Note   If the shared files on the other computer do not appear, you might need to first 
restart the computer you are using. 
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To copy a file or folder from a network computer to your local computer 

1. Use the preceding steps to browse to the shared file or folder that you want to copy. 

2. On the File menu, point to Explorer Bar, and then click Folders. The Folders bar 
appears in the left pane.  

You can now see the hierarchical structure of drives, folders, and files on your 
computer and on the other computers that are part of your network.  

3. Drag the file or folder that you want to copy from the right pane to a local drive or 
folder in the Folders bar. 

Note   If the shared network folder has read-write access, you can also copy files from 
your local computer into this shared folder. 

 

Using a Printer over a Network 
Before you can use a printer that is attached to another computer on your network, 
you will need to do the following: 

O Make the printer available to other computers (this is also known as “sharing” a 
printer). Sharing must be configured on the computer to which the printer is 
attached. 

O Run the Add Printer Wizard to install printer drivers on each computer that you want 
to print from. 

Note   Some printer drivers are not designed for sharing printers. For more information, 
see the documentation that came with your printer, or see if additional drivers are 
available on the printer manufacturer’s Web site. 

 

The procedures for sharing a printer and installing drivers differ depending on your 
version of Windows. For more detailed instructions, look up “sharing printers” in 
Windows Help.  

To access a shared printer from another computer on the network, use the following 
procedure. 

To print to a shared printer that is attached to another computer on the network  

1. Open the document that you want to print, such as a document in Microsoft Word. 

2. On the File menu, click Print.  

3. In the Print dialog box, select the shared printer from the list of printers, and then 
click OK. 

 

    Note   The computer that is connected to the printer must be turned on for the other 
computers on the network to use the printer. 
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Using Other Peripheral Devices over a Network 
In addition to using most printers over a network, you can use other peripheral 
devices—such as hard drives, CD drives, and Zip drives—over your network. Some 
peripheral devices (such as some scanners) cannot be shared with other computers 
on your network. 

Before you can use a device that is attached to another computer on your network, you 
will need to do the following: 

O Make the device available to the network (this is also known as sharing the device). 
This is configured from the computer to which the device is attached. 

O Install any necessary drivers or utilities on each computer from which you want to 
use the device. For more information, see the documentation that came with the 
device. 

About Reading E-Mail Messages on a Network 
You can access your e-mail messages from each networked computer in the same way 
that you would access e-mail messages without a local area network (assuming that 
you have an Internet connection). Open your e-mail program, or, if you have a Web-
based e-mail account, sign in to your account through your Web browser. 

Keep in mind the following: If you download e-mail messages from your e-mail account 
to your computer, those messages will not be accessible from the other computers on 
your network. Similarly, if you share an account with another person, and he or she 
downloads e-mail messages from the shared account to one computer on the network, 
you will not see those messages when you access the account from another computer. 

If you want your e-mail messages to remain available to all users of your network at 
any time, you should not download the messages to one computer. (However, you 
should delete old messages from your e-mail account on a regular basis, so that you 
don’t exceed the storage space given to you by your e-mail provider.)  

Playing Games on Your Network and on the Internet 
Many of the most popular games now have multiplayer capability, allowing two or more 
players to compete by using a local network. With network-enabled games, you can 
use your networked computers to play games with friends and family members. 

Most games come with documentation that explains all you need to know to configure 
your network for multiplayer gaming. However, the following steps might help you 
prepare for playing games over the network:  

O If you have purchased a multiplayer game, be sure to install it on each computer on 
the network that will be used for playing games.  

O Make sure that the network protocols necessary to run the games that you want are 
installed on each computer on your network. For more information, see the 
documentation that came with your games. 

O If you are playing an Internet-based game, you might also be required to pay user 
fees or download game files to your computer. Be sure to follow the directions 
provided on the game’s Web site. 
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O If you have problems connecting to an Internet-based game, you might need to 
configure your base station to work with your game. If you have a Microsoft base 
station, see the MN-500: Base Station Configuration Guide or MN-700: Base 
Station Configuration Guide on the Setup CD. 

 

For information about playing games on the Internet, and for other game-related 
information, visit: www.microsoft.com/broadbandnetworking. 

Creating a Computer-to-Computer (Ad Hoc) Network 
If you do not want to use a base station, you can set up a computer-to-computer (ad 
hoc) network to share files between computers that have wireless adapters. After you 
create an ad hoc network by using the following procedure, other computers can join 
this network by using the steps in the following section, “Joining an Available Wireless 
Network.”  

To set up an ad hoc network (in Windows XP) 

1. Start the Broadband Network Utility. 

2. On the Tools menu, click Adapter Settings. 

3. In the Wireless Adapter drop-down list, make sure that a Microsoft wireless adapter 
is selected. 

4. Click Configure. 

5. Click Add. 

6. Type a name for the new ad hoc network in the Network Name (SSID) box.  

7. If you want the network to use wireless security, enter the wireless security settings.  

8. Make sure that The key is provided for me automatically check box is not selected. 

9. Select This is a computer-to-computer (ad-hoc) network; wireless access points 
are not used.  

10. Click OK twice. 
 

To set up an ad hoc network (in Windows 2000, Windows Me, Windows 98, and 
Windows 98 SE) 

1. Start the Broadband Network Utility. 

2. On the Tools menu, click Adapter Settings. 

3. In the Wireless Adapter drop-down list, make sure that a Microsoft wireless adapter 
is selected. 

4. Click Configure. 

5. Type a name for the new ad hoc network in the Wireless name (SSID) box.  

6. Click This is a computer-to-computer (ad-hoc) network.  

7. If you want the network to use wireless security, enter a Wired Equivalent Privacy 
(WEP) key in the Security Key box, and to retype it in the Confirm Security Key box.  

Note   Use 10 alphanumeric characters for standard security or 26 for stronger security. 

8. Click OK twice. 
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Joining an Available Wireless Network 
By using the Broadband Network Utility, you can view any network that is within range 
and broadcasting its wireless network name (SSID). To join an available network, you 
simply select the network from a list of available networks and then change the 
wireless security settings of your adapter to match the settings of the network you 
want to join. 

To join an available network (in Windows XP) 

1. Start the Broadband Network Utility. 

2. On the Tools menu, click Adapter Settings. 

3. In the Wireless Adapter drop-down list, make sure that a Microsoft wireless adapter 
is selected. 

4. Click Available Networks. 

5. From the list of available networks, select the network you want to join.  

Note   If you are trying to join a computer-to-computer (ad hoc) network, and the 
network doesn’t appear, click Advanced, click Advanced again, and then make sure that 
the Any available network (access point preferred) option is selected. 

6. If WEP or Wi-Fi Protected Access™ (WPA) is enabled on the network you are joining, 
type the key or passphrase in the Network Key box.  

7. Click Connect. 
 

To join an available network (in Windows 2000, Windows Me, Windows 98, and 
Windows 98 SE) 

1. Start the Broadband Network Utility. 

2. On the Tools menu, click Adapter Settings. 

3. In the Wireless Adapter drop-down list, make sure that a Microsoft wireless adapter 
is selected. 

4. Click Available Networks. 

5. From the list of available networks, select the network you want to join.  

6. If the network that you want to join uses wireless security, you will be prompted to 
type the Wired Equivalent Privacy (WEP) key in the Security Key box, and to retype it 
in the Confirm Security Key box.  

7. Click Connect. 
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network 
management 
Understanding Network Maintenance and Security  
Now that you have a wireless network, it is a good idea to familiarize yourself with 
some important network management tasks.  

This chapter describes how to monitor network performance, view adapter settings, 
update network software, and improve network security. 

Monitoring Your Network 
The Microsoft® Broadband Network Utility is your principal tool for viewing the status of 
your network and connected devices and for viewing your adapter settings. 

 Note   For information about starting the Broadband Network Utility and using it to access 
shared files or to join other networks, see Chapter 4. 

View Status 
You can view information about the status of your computer, your workgroup or 
domain, and your Internet connection in the left pane of the Broadband Network 
Utility. If there is a problem with your network or Internet connection, the Broadband 
Network Utility displays a link to the Network Troubleshooter, which you can use to 
help resolve the problem.  

 Note   You can also view information about the status of your network connection by 
resting the pointer on the Broadband Network Utility icon  in the notification area at 
the far right of the Microsoft Windows® taskbar. 

View Network Devices 
The right pane of the Broadband Network Utility displays information about the 
computers, base stations, and other devices connected to your network. This 
information automatically refreshes at regularly scheduled intervals. You can manually 
refresh the list. 

To refresh the network device list 
O Right-click the icon for an active device in the network device list, and then click 

Refresh. 
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View Adapter Settings 
You can view the settings for your Microsoft wireless adapter from the Broadband 
Network Utility. These settings include the IP address, wireless network name (also 
known as Service Set Identifier, or SSID), and wireless channel.  

To view adapter settings 
O From the Tools menu of the Broadband Network Utility, click Adapter Settings.  

 

For information about how to change your adapter settings, see Broadband Network 
Utility Help.  

Updating Software 
Occasionally, Microsoft may provide upgrades to the Broadband Network Utility 
software. When an upgrade is available on the Microsoft Broadband Networking Web 
site, the Broadband Network Utility Update Service will automatically notify you, unless 
you turn the update service off. After you log on to a networked computer, a message 
will appear in the notification area of the Windows taskbar with a link to the Microsoft 
Broadband Networking Web site. 

If you turn the update service off, you can check for upgrades on the Web site from the 
Broadband Network Utility. 

To upgrade software 

1. Start the Broadband Network Utility. 

2. On the Help menu, click Check for Updates Online. 

3. Follow the instructions on the Microsoft Broadband Networking Web site to 
download the latest software, drivers, and firmware. 

 

Making Your Network More Secure 
Protecting the data and programs on your network computers from security threats, 
such as computer viruses and hackers, is very important. The following sections 
provide general information about steps you can take to protect your network.  

Help Protect Your Network from Computer Viruses 
To avoid having a problem with viruses on your network, consider the following 
suggestions: 

O Install an antivirus program on each computer on your network and use it regularly 
to check your computers for viruses. Remember to update the antivirus program on 
a regular basis. 

O Learn the common signs of viruses: unusual messages that appear on your screen, 
decreased system performance, missing data, and inability to access your hard 
drive. If you notice any of these problems on your computer, run your antivirus 
program immediately to minimize the chances of losing data.  

Download from Www.Somanuals.com. All Manuals Search And Download.



 Chapter 4: Network Management     25 

 

 

O Educate yourself about how viruses are commonly spread so that you do not spread 
one yourself: 

O Do not load a program from an untrusted source onto one of your network 
computers. Files from the Internet or online bulletin boards are particularly risky. 

O Never open attachments to e-mail messages that you are not expecting. 

O Use your antivirus software to scan all floppy disks before copying or opening 
files from them, or before starting your computer from them. 

 

Help Protect Your Network from Hackers 
If you have not already done so, consider purchasing the Microsoft Broadband 
Networking Wireless Base Station (sold separately) to establish a security layer 
between your networked computers and the Internet. The Microsoft Wireless Base 
Station provides network address translation (NAT) and a firewall to help secure your 
system from hacker attacks over the Internet. 

NAT hides the Internet protocol (IP) addresses of the computers on a network from the 
Internet so that only the base station IP address is visible. Without the IP address, it is 
more difficult for hackers to access the computers on your network. 

The firewall specifies what information can be communicated from the computers on 
your network to the Internet, and from the Internet to the computers on your network. 
Like an actual firewall built to prevent fire from spreading between adjoining buildings, 
computer firewalls help prevent the spread of unauthorized communication between 
an individual computer or group of networked computers and the Internet. 

Help Protect Your Network from Unauthorized Access 
Because wireless networks use radio signals, it is possible for other wireless network 
devices outside your immediate area to pick up the signals and either connect to your 
network or capture the network traffic. To help prevent unauthorized connections or 
the possibility of eavesdroppers listening in on your network traffic, do the following: 

O If you have a base station, router, or gateway, place it toward the center of your 
home. This decreases the strength of the signal outside your home. 

O Enable 128-bit wireless security (WEP) or WPA on your network when you run the 
Setup Wizard. When you enable WEP, you establish a WEP key that scrambles or 
“encrypts” the data being transmitted between wireless nodes so that it is 
decipherable only by computers that have the correct WEP key. In addition, only 
users who know the network WEP key can join your network and use your Internet 
connection. If you did not enable wireless security when you ran the Setup Wizard, 
you can do so from the Broadband Network Utility. 
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troubleshooting 
Finding Answers to Common Problems 
This chapter will help you solve the most common installation and setup problems that 
you may have with your Microsoft® Broadband Networking components. The following 
types of issues are covered: 

O Setup and Hardware Problems 

O Network and Internet Problems 

O File and Printer Sharing Problems 
 

If the problem you are experiencing is not covered in this chapter, you can find more 
troubleshooting information in Broadband Network Utility Help, or on the Microsoft 
Hardware Web site at www.microsoft.com/hardware. If you have finished Setup, you 
can start the Broadband Network Utility by double-clicking the icon in your Microsoft 
Windows® taskbar.   

Setup and Hardware Problems 
This section will help you solve problems that you might encounter while running the 
Setup Wizard or joining your network with your Microsoft Broadband Networking 
Wireless PCI adapter for the first time. 

 Note   Run the Setup Wizard before connecting your new hardware or disconnecting your 
existing Internet connection. This is important because the Setup Wizard will help detect 
your current settings and configure your new adapter. 

The Setup Wizard will not start or locks up when I run it on my 
computer. 
The following troubleshooting steps will help you track down and solve the problem. 

O Verify that your computer conforms to the minimum system requirements. The 
packaging lists system requirements for your Microsoft Broadband Networking 
adapter and software. If your computer does not meet the minimum requirements, 
the Setup Wizard might not function correctly or might not start at all.  

O Your hard disk might be full. Make sure that you have enough free hard disk space 
to install the network drivers and Broadband Network Utility. You can check the 
amount of free hard drive space by opening My Computer and selecting your hard 
drive in the main window. 

O Verify that your CD drive is functioning correctly. Try launching the Setup Wizard 
by double-clicking the CD icon in My Computer. If it still does not start correctly, try 
inserting another CD. If the other CD works correctly, you may have a bad CD. 
Contact Technical Support for more information about replacing a defective CD. 
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Setup does not recognize my wireless PCI adapter. 
The following troubleshooting steps will help you track down and solve the problem. 

O Verify that the status light is illuminated. Make sure that the status light labeled 
“Wireless” on your PCI adapter is illuminated to indicate that the adapter is 
receiving power and that the network has recognized and acknowledged the adapter.  

Check to make sure that your adapter, broadband modem, base station, and other 
networking devices are receiving power by inspecting the appropriate status lights. 

O Make sure that your PCI adapter is correctly installed. Verify that the PCI adapter 
is firmly connected to the PCI slot in your computer. A partially connected PCI 
adapter might cause your computer either to not turn on or to function incorrectly. 

If the adapter seems to be installed correctly but is still not working, and you have 
another available PCI slot in your computer, try moving the PCI adapter to that slot.  

O Make sure that all cables are securely connected. Check to see that the cables in 
your network are securely connected to the correct ports. Check all power cables 
and the Ethernet cables between the broadband modem and your network.  

Check the setup instructions for your broadband modem to make sure that you are 
using the correct type of Ethernet cable to connect to your modem, either straight-
through or crossover. See the network device documentation for more information 
about which cable type to use. 

After installing a new PCI adapter, my computer does not start. 
Installing a PCI wireless adapter inside your computer is one of the more technical 
tasks you might have to do when configuring your home or small office network. Since 
the card has to be installed inside the computer, you must take into consideration 
such issues as power consumption, card location, and tight connections.  

The following troubleshooting steps will help you track down and solve the problem. 

O Make sure that your PCI adapter is correctly installed. Verify that the PCI adapter 
is firmly connected to the PCI slot inside your computer. A partially connected PCI 
adapter might cause your computer either to not turn on or to function incorrectly. 

O Check your system specifications. Verify that the PCI slots in your system are at 
least PCI 2.1-compliant. This information is listed in the manual that came with your 
computer. 

O Use PCI slot 1. Try plugging the PCI adapter into PCI slot 1 in your computer. For 
specific information about which PCI slot is slot 1, see your computer 
documentation.  

Note   You may need to move a card currently in slot 1 to another slot in your 
computer. This troubleshooting step is recommended for users familiar with the 
internal workings of a computer. 

O Troubleshoot conflicts among your device resources. Resolve any device conflicts 
in the Microsoft Windows operating system. You can use Windows Troubleshooting 
to ensure that your PCI adapter is not trying to use computer resources already 
being used by another piece of hardware. For more information about resolving 
device conflicts, see Windows Help. 
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Network and Internet Problems 
This section will help you solve common issues that might occur while you are using 
your local area network (LAN) or Internet connection. 

I can’t stay connected to my wireless network. 
If you are running the Windows XP operating system with Service Pack 1 (SP1), you 
might lose connection to your wireless network every 3 to 5 minutes. This can be 
caused by incorrect wireless network security settings. To solve this problem, you need 
to disable 802.1x authentication on your wireless network, as described below. 

To disable 802.1x authentication in Windows XP 

1. Click Start, point to Connect To, click Show all connections, and then double-click 
your wireless network.  

2. On the General tab, click Properties.    

3. Click the Wireless Networks tab.  

4. Under Preferred Networks, click your home network, and then click Properties.    

5. Click the Authentication tab, and then click to clear the Enable IEEE 802.1x 
authentication for this network check box, if it is selected.  

6. If you cannot click this check box, then you are not using 802.1x authentication or 
wireless security.  

 

    Note   The security setting (such as a WEP key) that is used by your network adapter must 
match the security setting that is used by your base station, router, or gateway. 

I can’t access the Internet from a computer on my wireless network. 
The following troubleshooting steps will help you track down and solve the problem. 

O Make sure that the rest of your network is functioning correctly. Verify that you 
can access the Internet from other wireless and Ethernet computers on your 
network. If other computers also cannot access the Internet, the problem might be 
with your base station, modem, or Internet service provider (ISP).  

One other common cause of Internet connection problems is disconnected cabling. 
If the rest of your network is having problems, first check the cables between your 
computers and the base station or modem for loose connections or disconnected 
wires. Check the cables between the base station and the broadband modem. Verify 
that you are using the correct cables, that all cables are firmly attached, and that all status 
lights on the network devices indicate that your connections are functioning properly.  

O Check for range or interference issues. You might be out of range of the wireless 
base station or access point. If your computer is located near the outer limit of your 
wireless network, place the computer with the wireless adapter in the same room 
as your base station and try connecting again. If you can connect to the wireless 
network, you might previously have been out of range. If your computer is under 
your desk or in a tight space, try moving the computer away from the wall and 
readjusting the antenna on the PCI adapter. 
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Interference can also cause Internet connection problems. Signals that are 
transmitted between the base station and a wireless adapter can be affected by 
interference from other wireless devices—including 2.4 gigahertz (GHz) cordless 
phones, microwave ovens, and neighboring wireless networks. Move the other 
devices further from your wireless networking hardware as needed, and refrain from 
using them while you are using the network. To minimize interference from another 
wireless network, try changing channels. For more information about configuring 
your wireless settings, see Chapter 4, “Network Management.” 

For more information about range issues, see “Recommendations for Best Wireless 
Performance” in Help for the Broadband Network Utility. 

O Verify that you are using the correct wireless settings. You might have incomplete 
or incorrect wireless settings for your adapter. To connect successfully, the wireless 
adapter on your computer must have the same network name (SSID), wireless 
channel, and wireless security (such as Wireless Equivalent Privacy [WEP]) 
information as your base station. To check the wireless settings on your Microsoft 
base station, open the Base Station Management Tool (located within the 
Broadband Network Utility). You can also access the base station directly through 
your Internet browser by going to the address http://192.168.2.1. Then you can 
view and, if necessary, correct your Microsoft wireless adapter settings by opening 
Adapter Settings from the Tools menu of the Broadband Network Utility. 

O Reset your broadband modem. Turn off the modem for 5 to 10 seconds. Restart 
the modem, and wait for it to connect to your ISP. After the status lights on your 
modem indicate that it is connected, and the status lights on your base station 
show that you have a working wide area network (WAN) connection, try accessing 
the Internet from your computer again. 

O Reset your base station, gateway, or router. Turn off or unplug the base station, 
wait at least 10 seconds, and turn it back on again. Let the base station reset itself. 
When the status lights indicate that the base station is functioning, try accessing 
the Internet from the wireless computer again. 

O Update your base station firmware. Firmware is the software that is loaded into 
your base station to provide network functions. You can update your base station 
firmware by downloading it from the Internet and installing it on your base station. If 
you are using a Microsoft base station, make sure that you are using the latest 
firmware version.  

To update Microsoft base station firmware  

1. Double-click the Broadband Network Utility icon on your taskbar to start  
the utility. 

2. On the Help menu, click Check for Updates Online.  

3. If there is a newer version of the firmware available, follow the instructions on 
the Web page to download the new software, firmware, or drivers.  
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My network is slow. 
If networked programs are running slowly, or you are experiencing large slowdowns in 
your Internet connection speed, try decreasing the number of computers or programs 
that are simultaneously accessing your network. 

   Note   Programs that do not use network resources, for example Microsoft Word when it is 
editing a local document, will not interfere with the speed of your network. Only programs 
that must constantly use your network connection to function will be affected. Examples 
can include music sharing software and instant messenger programs. 

Your network has a limited amount of bandwidth for transmitting data. As more 
computers access your network at the same time, the bandwidth must be divided 
between all computers. By reducing the number of programs accessing your network 
at the same time, you can increase the speed at which data is transmitted across  
your network. 

You might find that you need more bandwidth to use all of your computers at the same 
time on the network. If your connection is still too slow, contact your ISP to verify that 
there are no problems with your connection, such as scheduled maintenance, line 
issues, or other problems. If you are still not satisfied with your connection speed, you 
might want to inquire about upgrading to a faster connection. 

I am having problems running a networked program or multiplayer 
game on my network or the Internet. 
Some networked applications might not be working as expected on your local area 
network (LAN). Symptoms of the problems vary and can include the following:  

O Problems connecting to an application after the base station is installed.   

O Disconnections while using an application.   

O Problems sending or receiving audio and video.   

O Problems connecting more than one computer to an online application 
simultaneously.  

O Delays, or lag, while running a multiplayer game on several computers at once. 

O Game crashes. 

O Delays, or lag, while playing a game over the Internet. 
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Several troubleshooting steps addressing these issues are listed below, with solutions 
to the most common problems listed first. 

O Make sure that the rest of your network is functioning correctly. Verify that you 
can access the Internet from other computers on your network. If other computers 
also cannot access the Internet, the problem might be with your base station, 
modem, or Internet service provider (ISP). See the following troubleshooting steps 
for more information. 

If this network does not have an Internet connection, verify that all computers are in 
the same workgroup and can see each other on the network. You can use the 
Broadband Network Utility to view all the computers in your workgroup and check 
your workgroup name. For more information about the Broadband Network Utility, 
see Chapter 3, “Network Activities.”  

If there are problems accessing the Internet or other computers on your network, 
check the cables between your computers and the base station or modem for loose 
or disconnected wires. Check the cables between the base station and the 
broadband modem. Verify that you are using the correct cables, that all cables are 
firmly attached, and that all status lights on the other network devices are 
functioning correctly.  

If you are still having network problems, you should troubleshoot that issue before 
configuring a multiplayer network game. 

O Check your base station network settings. If other computers on your network are 
also having problems accessing the network and the Internet, you might have 
incorrect base station network settings. Verify that you are using the correct Internet 
settings required by your ISP, and that any wireless settings are correctly configured 
to allow all wireless computers to communicate. 

If you are using a Microsoft base station, you can use the Broadband Network Utility 
and the Base Station Management Tool to check and manually configure your 
network settings. For more information, see Chapter 4, “Network Management.” If 
you are using a base station or router from another manufacturer, see the 
documentation for that device.  

O Check if your game or application has any special network requirements for 
multiplayer play. Some programs communicate between computers by using 
specific network ports. Most base stations include a firewall that prevents 
unauthorized communication on nearly all ports.  

If your application or game requires special settings on your base station, such as 
forwarding a port for multiplayer play or setting up a virtual DMZ (demilitarized 
zone) to host a game server, you will be able to find this information in the program 
manual or on the software publisher’s Web site. 

For a list of specific programs and the ports necessary to run them, see the Support 
section of the Broadband Networking Web site at www.microsoft.com/hardware. 
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O If you are using a wireless connection, check for range and interference issues. 
You might be out of range of the wireless base station, gateway, or router. Position 
the computer with the wireless adapter in the same room as your base station and 
try connecting again. If you can connect to the wireless network and run 
applications and games without a problem, you might have been previously out  
of range.  

Another cause of problems is that signals transmitted between the base station and 
a wireless adapter can be affected by interference from other wireless devices—
including 2.4 GHz cordless phones, microwave ovens, and neighboring wireless 
networks. Move the other devices as needed, and refrain from using them while you 
are using the network. To minimize interference from another wireless network, try 
changing the wireless channel. For information about how to change your wireless 
settings, see Broadband Network Utility Help. 

O Check for duplicate NAT features, DHCP servers, or firewalls. Network Address 
Translation (NAT) and Dynamic Host Configuration Protocol (DHCP) are security 
features of the Microsoft base station and some other devices. If two devices, such 
as a base station and modem, are running NAT and/or DHCP servers at the same 
time, the devices can interfere with each other and cause intermittent failures. If 
you are running a Microsoft base station, for example, its firewall and NAT features 
could conflict with other network hardware and software. Verify that you have 
disabled NAT functionality and DHCP servers on other devices in your network. To 
determine if a device has one of these features, check the documentation for that 
device. Some other common network devices that could contain these features 
include routers, broadband modems, or wireless access points. 

Software firewalls can also cause conflicts. Make sure that you turn off any 
personal firewall software, such as Internet Connection Firewall, when trying to run 
a game. 

O Update your base station firmware. Firmware is the software that is loaded into 
your base station to provide network functions. You can update your base station 
firmware by downloading it from the Internet and installing it on your base station. If 
you are using a Microsoft base station, make sure that you are using the latest 
firmware version.  

To update Microsoft base station firmware  

1. Double-click the Broadband Network Utility icon on your taskbar to start  
the utility. 

2. On the Help menu, click Check for Updates Online.  

3. If there is a newer version of the firmware available, follow the instructions on 
the Web page to download the new software, firmware, or drivers.  
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Printing and File Sharing Issues 
This section will help you solve problems you might encounter while printing over your 
network or accessing shared files and folders. 

I can’t print to a networked printer. 
The following troubleshooting steps will help you track down and solve the problem. 

O Make sure that the printer is functioning properly. There could be a problem with 
the printer itself. Verify that the printer is on and working correctly by using the 
printer’s self-test functions. See your printer documentation for specific 
instructions. 

If the printer fails the self test, try turning the printer off and back on again. Make 
sure that the printer has ink and paper. If the printer is still failing, see the printer 
documentation. 

If the printer passes the self test, try printing from the computer that is connected 
directly to the printer. If this computer will not print successfully, you may need to 
install printer drivers or check the cable connecting the printer to your computer. 
See below for more information. 

O Make sure that all cables are securely connected. Check that the cables in your 
network are securely connected to the correct ports. Check all power cables and the 
cables between the printer and the host computer or network. Make sure that the 
status lights on the base station and each network adapter are illuminated to 
indicate that each connected Ethernet port is working properly. If the status lights 
are not illuminated, try a different type of Ethernet cable (straight-through or 
crossover) or a different network port. 

O Ensure that the printer is shared over your network. If your printer is connected to 
a computer, which is then connected to your network, you must make that printer 
available to other computers. This process is known as “sharing” a printer over  
the network. 

To make a printer available to the network, go to the computer that is connected 
directly to the printer. Follow instructions for printer sharing for that computer’s 
operating system. For more information about sharing a printer over the network, 
see Windows Help. 

 

O Check whether the correct printer driver is installed. Every computer that will use 
a shared printer on your network must have that printer’s driver installed. You can 
make sure that the driver for the networked printer has been installed on a 
computer by checking the Printers item in Control Panel. If it is installed, you will 
see your shared printer listed in the Printers section. After you have verified that 
the printer driver is installed, try printing a test page from the computer. 

You can install the printer driver by opening Printers and Faxes through Control 
Panel in Windows XP, or through the Add Printer feature in Control Panel on other 
Windows operating systems. If Windows prompts you for a driver disk, use the driver 
disk that came with your printer. 
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I cannot access a shared file or folder from a computer on my network. 
Files and folders are “shared” when they are made available to other users on your 
network from the computer on which they reside.  

The following troubleshooting steps will help you track down and solve the problem. 

O Make sure that your network is functioning correctly. By checking the status of 
your network, you can determine if the problem is due to a connectivity issue with 
your network or if the problem is due your shared file configuration. One easy way to 
check the status of your network is to verify that all of the computers can access 
the Internet. If you are having problems accessing the Internet (possibly caused by 
loose or incorrect cables), fix those problems before proceeding with other 
troubleshooting methods listed here.  

O Try accessing a different shared file or folder. If there are other shared resources 
on your network, try accessing those resources instead. If you can access other 
shared files but not the one you want, you might not have permission to access the 
file. For more information about permissions, see below. 

O Ensure that all computers are in the same workgroup. You will need to look at 
each computer to check its workgroup and, if necessary, change the workgroup 
name.  

Note   If one of your computers is a laptop that is used on a domain at work, you must 
leave the domain to join a workgroup at home and share files. To rejoin the domain at 
work, you will need administrative privileges on your computer. For more information, 
see Windows Help. 

If the computer is using a Microsoft Broadband Networking adapter, you can check 
which workgroup your computer belongs to on the main screen of the Broadband 
Networking Utility. Alternatively, you can check and modify the workgroup names on 
each computer by using the following instructions, specific to the Windows 
operating system: 

 

Windows XP 

1. Click Start, and then click Control Panel. 

2. Double-click System, and then click the Computer Name tab. If you need to 
modify the workgroup name, click Change. 

 

Windows 2000 

1. Click Start, point to Settings, and then click Control Panel. 

2. Double-click System. 

3. Click the Network Identification tab. If you need to modify the workgroup name, 
click Change. 
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Windows 98, Windows 98 SE, and Windows Me 

1. Click Start, point to Settings, and then click Control Panel. 

2. Double-click Network, and then click the Identification tab. If you need to modify 
the workgroup name, click Change. 

 

When all computers are members of the same workgroup, try sharing or accessing 
shared files again. 

O Turn on file and printer sharing on the computer that contains the file you want 
to share. The computer that you are trying to access must have file and printer 
sharing enabled for sharing to work correctly. When you run the Setup Wizard, you 
have the option of enabling file and printer sharing, but that option applies only to 
the computer running Setup. If a different computer contains the file that you want 
to share, you also will need to enable sharing on that second computer.  

File and printer sharing is enabled differently on each operating system. For  
more information about enabling file and printer sharing on your computer, see 
Chapter 3, “Network Activities.”  

O Verify that the file or folder’s permissions have been configured for access over 
the network. When files or folders are shared over the network, they still may not 
be accessible by everyone. Their owner may configure permissions that limit which 
users can read, write to, or delete the shared resources. If you are having difficulty 
accessing a file or folder on another computer, it may be because the permissions 
for that file limit your ability to see it over the network. You may receive an “access 
denied” error message, or have problems locating the shared files on your network. 

To check the permissions for shared files or folders, go to the computer containing 
those files or folders. In Windows XP operating system, right-click the folder 
containing the information you want to access and choose Properties. Click the 
Sharing tab to see if file sharing has been enabled. If the computer is using Simple 
File Sharing in Windows XP, files are either shared to everyone or not shared at all, 
and permissions cannot be modified. In other words, a shared file should be 
accessible from another computer. If the computer is not using Simple File Sharing 
(recommended), click the Security tab to check and modify permissions for each 
user accessing the folder.  

Note   Microsoft Windows XP Home Edition uses only Simple File Sharing. Microsoft 
Windows XP Professional Edition uses both Simple File Sharing and standard, 
permissions-based file sharing. 

To check permissions in Windows 2000, Windows 98, Windows 98 SE, and 
Windows Me operating systems, right-click the file or folder whose permissions you 
want to check and choose Sharing.  

For more information, search for “file and folder permissions” and “simple file 
sharing” in Windows Help.  
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I can open shared files or folders, but cannot write to or delete them. 
The following troubleshooting steps will help you track down and solve the problem. 

O Check to see if the file is read-only. “Read-only” is a file attribute that prevents 
anyone from writing to the file or otherwise making alterations. To check the 
attributes of a file, locate the file in its folder, right-click the file, and choose 
Properties. Attributes can be changed only by a user who has administrative 
privileges on the computer where the file is located. 

O Check to see if you have permission to change the shared file or folder. When 
files or folders are shared over the network, they still might not be accessible by 
everyone. Their owner can configure permissions that limit which users can read, 
write to, or delete the shared resources. If you are having difficulty accessing a file 
or folder on another computer, it might be because the permissions for that file limit 
your ability to share it. You might receive an “access denied” error message, or have 
problems locating the shared files on your network. 

For more information about checking and setting permissions, see Broadband 
Network Utility Help.  

Note   Windows XP Home Edition uses only Simple File Sharing. Windows XP 
Professional Edition uses both Simple File Sharing and standard, permissions-based  
file sharing. 

 

I can only access shared resources from certain computers or user 
accounts on my network. 
When you are able to access shared files from certain computers or user accounts on 
your network, but not others, it may be because the file’s owner has limited the access 
to certain users. To check the user permissions on a file, you will need to go to the 
computer that owns the file.  

To check user permissions on a computer running the Windows XP operating 
system 

1. Right-click the file you wish to check and click Sharing and Security. 

2. Click the Security tab. 

3. Users who have permissions for this shared resource are listed in the Group or user 
names list box. You can use the Add and Remove buttons to modify the list, and 
use the Permissions for section to change specific tasks available to each user. 

4. Click OK to save the changes. 
  

To check permissions in Windows 2000, Windows 98, Windows 98 SE, and  
Windows Me, right-click the file or folder in question and choose Sharing.  

For more information, search for “file and folder permissions” in Windows Help. 
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appendixes 
Appendix A: Locating Your Internet and 
Network Settings 
If the Setup Wizard cannot detect your settings, or if you are setting up a product 
without using the Setup Wizard, you will need to enter your Internet and local area 
network (LAN) settings manually. The following instructions will help you locate the 
settings that you need. You can record this information on the inside back cover of this 
User’s Guide for future reference.  

Internet Connection Type 
You connect to your Internet service provider (ISP) by using one of three connection 
types: 

O Dynamic (by using Dynamic Host Configuration Protocol, or DHCP) 

O Static 

O Point-to-Point Protocol over Ethernet (PPPoE) 
 

Each type of Internet connection requires different settings when you set up a network 
device.  

To determine which connection type your ISP provides 
O See the documentation provided by your Internet service provider or contact  

your ISP. 

O If you have a Microsoft® base station set up on your network, you can use the Base 
Station Management Tool. Click Wide Area Network and view the settings under 
Internet Connection Type.  

O If you have a broadband modem that came with a configuration utility, try using  
this utility.  

O If you have a non-Microsoft base station, gateway, or router, try using the utility that 
came with your base station. 
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General Internet Settings 
If you have not set up a base station, gateway, or router, and you have an adapter that 
is currently configured correctly for your ISP, you can use the following procedure to 
locate most of the Internet settings you need. 

To locate your Internet settings 

1. On the Start menu, click Run. 

2. Do one of the following: 

O If you have Microsoft Windows® XP or Windows 2000, type cmd 

O If you have Windows Me, Windows 98, or Windows 98 SE, type command 

3. At the command prompt, type ipconfig /all 
 

Dynamic IP (DHCP) Settings 
When you set up a base station to have a dynamic IP address, the ISP will sometimes 
require a host name or a MAC address. 

Host Name 
Some ISPs record your computer name (also known as your host name) when you set 
up your ISP account. You might need to find your computer’s name when you set up a 
base station. 

   Note   For information about changing your computer name, see Help in the Broadband 
Network Utility. 

To determine your computer name in Windows XP or Windows 2000 

1. Click Start, click Control Panel, and then double-click System. 

2. Do one of the following: 

O If you have Windows XP, click the Computer Name tab.  

O If you have Windows 2000, click the Network Identification tab. 
 

To determine your computer name in Windows Me, Windows 98, and Windows 98 SE 

1. Click Start, point to Settings, and then click Control Panel. 

2. Double-click Network, and then click the Identification tab. Your computer name 
appears in the Computer name box. 

 

MAC Address 
A media access control (MAC) address is a unique alphanumeric identifier that is 
printed or stamped on every networking device by the manufacturer. A MAC address 
looks something like the following: 0050F2731958. Some Internet service providers 
record the MAC address of the modem or adapter you’re using when you sign up for 
the service. To determine whether your Internet connection requires a MAC address, 
see the information provided by your ISP. 
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You can find the MAC address for your Microsoft adapters printed on the label. You 
can find the base station MAC address on the side of the base station (or on the 
underside if the base station is positioned vertically).  

   Note   For information about cloning a MAC address, so that the setting conforms to the 
MAC address on record with your ISP, see Help in the Broadband Network Utility. 

Static IP Settings 
When you set up the base station to use a static IP address, you will need the IP 
address, subnet mask, and default gateway. You might also need primary and 
secondary Domain Name Server (DNS) settings. 

Use any of the following methods to determine these settings:  

O See the documentation provided by your Internet service provider or contact  
your ISP. 

O Use one of the following procedures, depending on your version of the Windows 
operating system. 

 

   Note   For information about configuring a static IP address on an adapter, see Help in the 
Broadband Network Utility.  

To locate your static IP address settings (Windows XP) 

1. Do one of the following: 

O Click Start, click Control Panel, click Network and Internet Connections, and 
then double-click Network Connections. 

O Click Start, click Control Panel, and then double-click Network Connections.  

2. In the Network Connections window, right-click your Internet connection, and then 
click Properties.  

3. Select Internet Protocol (TCP/IP), and then click Properties.  

4. Under Use the following IP Address, note the settings for IP address, subnet mask, 
and default gateway name.  

5. Note whether your connection obtains a DNS server address automatically, or 
whether it uses a specific address or addresses.  

 

To locate your static IP address settings (Windows 2000) 

1. Click Start, point to Settings, click Control Panel, and then double-click Network 
and Dial-Up Connections. 

2. In the Network and Dial-Up Connections window, right-click your Internet 
connection, and then click Properties.  

3. On the General tab, select Internet Protocol (TCP/IP), and then click Properties.  

4. On the General tab, under Use the following IP address, note the IP addresses.  

5. Click Advanced to see the gateway information. 

6. On the DNS Configuration tab, note the DNS addresses. 
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To locate your static IP address settings (Windows Me, Windows 98, and 
Windows 98 SE) 

1. Click Start, point to Settings, click Control Panel, and then double-click Network. 

Note   If you do not see the Network item in Control Panel, click View all control panel 
options on the left side of the screen. 

2. On the Configuration tab, select TCP/IP, and then click Properties. 

Note   If there is more than one TCP/IP option listed, select the option for your Ethernet 
adapter, not your dial-up adapter.  

3. On the IP Address tab, under Specify an IP Address, note the IP addresses.  

4. On the Gateway tab, note the gateway information. 

5. On the DNS Configuration tab, note the DNS addresses. 
 

PPPoE Settings 
To find your user name, password, and service name (if needed)  

O See the documentation provided by your Internet service provider or contact  
your ISP. 

O If your computer is running Windows XP, double-click the Network Connections 
icon in Control Panel. A PPPoE Internet connection typically appears under 
Broadband and includes the descriptor WAN Miniport (PPPOE). Double-click this 
icon for more information. 

O If your computer is running Windows 2000, Windows Me, Windows 98, or  
Windows 98 SE, you installed access software when you set up the Internet 
connection. You can check this software for more information.  

O If you have an existing base station, gateway, or router and are replacing it with a 
Microsoft base station, you can use your existing network configuration utility.  

O If you are replacing an existing Microsoft base station, you can use the Base Station 
Management Tool. Click Wide Area Network.  

Workgroup Name 
If you want to add a computer to your workgroup, you need to know the workgroup 
name.  

    Note   For information about changing your workgroup name, see Help in the Broadband 
Network Utility. 

To determine your workgroup name in Windows XP or Windows 2000 

1. Click Start, click Control Panel, and then double-click System. 

2. Do one of the following: 

O If you have Windows XP, click the Computer Name tab.  

O If you have Windows 2000, click the Network Identification tab. 
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To determine your workgroup name in Windows Me and Windows 98 

1. Click Start, point to Settings, and then click Control Panel. 

2. Double-click Network, and then click the Identification tab. Your workgroup name 
appears in the Workgroup box. 

 

Wireless Network Name  
Your wireless network name, or SSID, uniquely identifies your wireless network and is 
case sensitive. 

O If you have the Broadband Network Utility installed on a computer on your network, 
you can use it to identify your wireless network name.  

O If you have a Microsoft wireless base station, you can use the Base Station 
Management Tool. On the home page, click Wireless.  

O If you have a non-Microsoft base station, gateway, or router, use the network utility 
that came with your base station. 

  

Wireless Security Settings 
Use these methods to locate your Wired Equivalent Privacy (WEP) key or Wi-Fi 
Protected Access™ (WPA) passphrase. 

O If you have a Microsoft wireless base station, you can use the Base Station 
Management Tool. On the Security menu, click Wireless Security. 

O If you have a non-Microsoft base station, gateway, or router, use the network utility 
that came with your base station.  

O If you are connecting to a corporate network, ask your network administrator.  
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Appendix B:  
Support and Technical Information 
This appendix contains the following reference information for your Broadband 
Networking products: 

O Getting Help 

O Regulatory Information  

O Technical Specifications 

O System Requirements 

O Limited Warranty 

Getting Help 
If you have a question about your Microsoft® Broadband Networking products, the 
following resources on the Web, in Help, and from Technical Support may help you find 
the answer. 

Visit Us on the Web 
Please visit the Microsoft Broadband Networking Web site at www.microsoft.com/ 
broadbandnetworking for the most up-to-date information about our products. The 
Microsoft Broadband Networking Web site also contains many articles on diagnosing 
network problems, setting up new features, and installing new networking hardware. 

Click Help in the Broadband Network Utility 
Go to the Help menu in the Microsoft Broadband Network Utility for extensive 
information about our products and for detailed troubleshooting information to help 
you identify and solve common networking problems. 

Technical Support Options 
Product Name:  Microsoft Broadband Networking Wireless PCI Adapter (MN-730)  

Support Info   For all of our support offerings, visit http://support.microsoft.com 
Online: In Canada, visit www.microsoft.ca/support 

Phone  Toll-free support for U.S. customers: (800) 936-3900.For customers  
Support:  in Canada: (800) 668-7975. These numbers are only for support of  
 Microsoft Broadband Networking products.  

TTY Users:  Text phone (TTY/TDD) services are available at (425) 635-4948 in 
 Washington state or (800) 892-5234 in the U.S. Call (905) 568-9641  
 in Canada.   

Worldwide: Support outside the U.S. and Canada may vary. For regional  contact 
 details, visit http://support.microsoft.com/ international.aspx. If there 
 is no Microsoft subsidiary office in  your country or region, please contact 
 the establishment from which you obtained your Microsoft product. 

Conditions: Microsoft’s support services are subject to then-current prices,  terms, 
 and conditions, which are subject to change without notice. 
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Regulatory Information 

United States Radio and TV Interference Regulations 
This device complies with Part 15 of the U.S. Federal Communications Commission (FCC) rules. Operation is 
subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired operation. 

The Microsoft hardware device(s) that accompanies this software can radiate radio frequency (RF) energy. If not 
installed and used in strict accordance with the instructions given in this User’s Guide, the device may cause 
harmful interference with other radio-communications devices (for example AM/FM radios, televisions, baby 
monitors, cordless phones, etc.). Any cable that is connected to the device must be a shielded cable that is 
properly grounded. There is, however, no guarantee that RF interference will not occur in a particular installation. 

Your Microsoft hardware device has been tested, and it complies with the limits for a Class B digital device in 
accordance with the specifications in Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful RF interference in a residential installation. 

To determine if your hardware device is causing interference to other radio-communications devices, disconnect 
the device from your computer. If the interference stops, it was probably caused by the device. If the interference 
continues after you disconnect the hardware device, turn the computer off and then on again. If the interference 
stopped when the computer was off, check to see if one of the input/output (I/O) devices or one of the 
computer's internal accessory boards is causing the problem. Disconnect the I/O devices one at a time and see if 
the interference stops. 

If this hardware device does cause interference, try the following measures to correct it: 

O Relocate the antenna of the other radio-communications device (for example AM/FM Radios, televisions, 
baby monitors, cordless phones, etc.) until the interference stops.  

O Move the hardware device farther away from the radio or TV, or move it to one side or the other of the radio or 
TV.  

O Plug the computer into a different power outlet so that the hardware device and radio or TV are on different 
circuits controlled by different circuit breakers or fuses.  

O If necessary, ask your computer dealer or an experienced radio-TV technician for more suggestions. You may 
find helpful information about interference issues at the following FCC Web site: 
http://www.fcc.gov/cgb/consumerfacts/interference.html, or call the FCC at 1-888-CALL FCC to request from 
the operator “Interference and Telephone Interference” fax sheets. 

Note 
Any changes or modifications not expressly approved by Microsoft could void the user’s authority to operate this 
device. 

For use with UL Listed and GS approved personal computers. 

Not intended for use in machinery or industrial applications. 

Tested to comply with FCC Standards. For home and office use. 

Microsoft Corporation 
One Microsoft Way 
Redmond, WA 98052-6399.  
(800) 426-9400 (United States)  
(800) 933-4750 (Canada) 

Canadian Radiocommunication Regulations 
This Class B digital apparatus complies with Canadian ICES-003. 

The term “IC:” before the certification/registration number only signifies that the Industry Canada technical 
specifications were met. 

Cet appareil numérique de la classe B est conforme aux normes NMB-003 du Canada. 

L’expression «IC:» avant le numéro d’homologation/enregistrement signifie seulement que les spécifications 
techniques d’Industrie Canada ont été respectées. 

Download from Www.Somanuals.com. All Manuals Search And Download.



 

46     Microsoft Broadband Networking Wireless PCI Adapter User’s Guide 

 

 

Technical Specifications  
Wireless PCI Adapter 

Standards IEEE 802.11b, 802.11g, Wi-Fi certified 

Host Interface PCI card slot, 32-bit, 5V 

Data Rate  1, 2, 5.5, 6, 11, 12, 18, 24, 36, 48, 54 Mbps with Auto-fallback support 

Modulation  CCK, DBPSK, DQPSK, OFDM 

Frequency Range ISM Band (2.400 to 2.4835 GHz) 

Channels 1-11 United States, Canada 

Approved for use only in the United States and Canada. 

Wireless Security WEP: Off, 64-bit, and 128-bit 
WPA: 256-bit 

Indicators Wireless Activity LED, Power LED 

Operating 
Temperature 

0 to +35 deg C 

Storage Temperature -20 to +60 deg C 

Humidity 10 to 85 percent non-condensing 

Emissions FCC Part 15 Class B; Canada RSS-210 

Safety UL 

Physical Dimensions 4.7" x 5.2" x 0.8" (119.4 X 132.1 X 20.3 mm) 

Weight  3.17 oz (98.7 g) 
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System Requirements 
To use the Microsoft Broadband Networking Wireless PCI Adapter (MN-730),  
you need: 

O Microsoft Broadband Networking Wireless Base Station or other Wi-Fi
®

 access point 

O PC with an available PCI slot; PC drivers are included for Microsoft Windows
®

 98, 
Windows 98 SE, Windows Millennium Edition (Windows Me), Windows 2000 
Professional, Windows XP Professional, and Windows XP Home Edition operating 
systems 

 

To use the Microsoft Broadband Networking Setup Wizard and Broadband Network 
Utility, you need: 

O PC running Microsoft Windows 98, Windows 98 SE, Windows Millennium Edition 
(Windows Me), Windows 2000 Professional, Windows XP Professional, or 
Windows XP Home Edition operating system 

O Microsoft Internet Explorer version 5.0 or later; setup will install Internet Explorer 
6.0 browser components if needed, but will not displace your primary browser 

O 132 MB of available hard-disk space if you are installing Internet Explorer for the 
first time; 40 MB of available hard-disk space if you already have Internet Explorer 
5.5 or 6.0 installed 

O 4x CD-ROM drive 

O VGA or higher resolution monitor; Super VGA recommended  
 

Recommended: 

O Microsoft Mouse or compatible pointing device 

O 3.5" high-density disk drive or other removable media to share network settings 
between PCs 

Not all ISPs allow you to share a broadband connection. Please check with your ISP.  
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END-USER LICENSE AGREEMENT FOR MICROSOFT SOFTWARE 
IMPORTANT—READ CAREFULLY: Be sure to carefully read and understand all of the rights and restrictions 
described in this Microsoft End-User License Agreement (“EULA”), which includes the Software Product License, 
General Provisions and Limited Warranty and Limitation of Liability. You will be asked to review and either accept 
or not accept the terms of the EULA. The SOFTWARE will not set up on Your computer unless or until You accept 
the terms of this EULA. 

Your click of the “accept” button is a symbol of Your signature that You accept the terms of the EULA. 

NOTE: The terms of this printed, paper EULA supersede the terms of any on-screen EULA found within the 
SOFTWARE. 

This EULA is a legal agreement between You (either an individual or a single legal entity who will be refered to in 
this EULA as “You” and “Your”) and Microsoft Corporation and includes the Software Product License for the 
software portion of this Hardware Device, which includes the accompanying computer software, and may include 
associated media, printed materials and any “online” or electronic documentation (“SOFTWARE”). This EULA is 
valid and grants the end-user license rights ONLY if the SOFTWARE is genuine Microsoft software. By installing, 
copying or otherwise using the SOFTWARE, You agree to be bound by the terms of this EULA. If You do not agree 
to the terms of this EULA, do not install or use the SOFTWARE; You should return the SOFTWARE and 
accompanying Microsoft Hardware Device to Microsoft or Your place of purchase for a refund. 

SOFTWARE PRODUCT LICENSE 
The SOFTWARE is protected by copyright laws and international copyright treaties, as well as other intellectual 
property laws and treaties. The SOFTWARE is licensed, not sold.  

1. GRANT OF LICENSE. This EULA grants You the following rights: 

O Software Installation and Use. Except as otherwise expressly provided in this EULA, You may only install, use, 
access, run, or otherwise interact with (“Run”) one copy of the SOFTWARE on a single computer, such as a 
workstation, terminal, or other digital electronic device (“Workstation Computer”) to which the enclosed 
Hardware Device is attached. You may also Run a copy of the SOFTWARE on any computers or other 
electronic devices (each a "Computer" and collectively the “Computers”) that are connected or networked to 
the Workstation Computer through the Hardware Device.  

O Reservation of Rights. Microsoft reserves all rights not expressly granted to You in this EULA. 

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.  
O Operating System Upgrades. The SOFTWARE may contain systems components software upgrades required 

for proper operation of the SOFTWARE. Any such systems software upgrades are licensed to You pursuant to 
the terms and conditions as provided in Your license to the operating system unless a separate end user 
license agreement is provided to You with such upgrades, in which case such separate agreement governs 
Your use of the upgrades. 

O Multiple Hardware Devices. If You purchased a multiple pack of the Hardware Device, You may make one (1) 
copy of the SOFTWARE for each Hardware Device You purchased in the package, and You may use each copy 
in the manner specified above. 

O Limitations on Reverse Engineering, Decompilation and Disassembly. You may not reverse engineer, 
decompile, or disassemble the SOFTWARE, except and only to the extent that such activity is expressly 
permitted by applicable law notwithstanding this limitation. 

O Separation of Components. The SOFTWARE is licensed as a single product. Its component parts may not be 
separated for use on more than one computer. 

O Rental. You may not rent or lease or lend the SOFTWARE.  

O Single Computer. The SOFTWARE is licensed with the Hardware Device as a single integrated product. The 
SOFTWARE may only be used with the Hardware Device as set forth in this EULA. 

O Software Transfer. You may permanently transfer all of Your rights under this EULA only as part of a transfer 
of the Hardware Device, provided You retain no copies, You transfer all of the SOFTWARE (including all 
component parts, the media and printed materials, any upgrades, this EULA and, if applicable, the Certificate 
of Authenticity) along with the accompanying Hardware Device, and the recipient agrees to the terms of this 
EULA. If the SOFTWARE portion is an upgrade, any transfer must include all prior versions of the SOFTWARE. 

O Not For Resale Software. If the SOFTWARE is labeled “Not for Resale” or “NFR”, then, notwithstanding other 
sections of this EULA, You may not resell, or otherwise transfer for value, the SOFTWARE.  

O Auto Updates. You acknowledge and agree that Microsoft may automatically check the version of the 
SOFTWARE and/or its components You are utilizing and may provide upgrades and/or supplements to the 
SOFTWARE and/or its components that will be automatically downloaded to the Workstation Computer and all 
Computers. Your use of the SOFTWARE including such upgrade and/or supplement shall be governed by this 
EULA.  

O Termination. Without prejudice to any other rights, Microsoft may terminate Your rights under this EULA if You 
fail to comply with the terms and conditions of this EULA. In such event, You must destroy all copies of the 
SOFTWARE and all of its component parts.  

O Trademarks. This EULA does not grant You any rights in connection with any trademarks or service marks of 
Microsoft or its suppliers. 
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O Support Services. Microsoft may provide You with support services related to the SOFTWARE and/or 

Hardware Device (“Support Services”). Use of Support Services is governed by the Microsoft policies and 
programs described in the user manual, in “online” documentation, and/or other Microsoft-provided 
materials. Any supplemental software code provided to You as a part of Support Services shall be considered 
part of the SOFTWARE and subject to the terms of this EULA. With respect to technical information You 
provide to Microsoft as part of the Support Services, Microsoft may use such information for its business 
purposes, including for product support and development. Microsoft will not utilize such technical information 
in a form that personally identifies You.  

3. COPYRIGHT. All title and intellectual property rights in and to the SOFTWARE (including but not limited to any 
images, photographs, animations, video, audio, music, text and “applets,” incorporated into the SOFTWARE), the 
accompanying printed materials, and any copies of the SOFTWARE, are owned by Microsoft or its suppliers. All 
title and intellectual property rights in and to the content which is not contained in the SOFTWARE but may be 
accessed through use of the SOFTWARE is the product of the respective content owner and may be protected by 
applicable copyright or other intellectual property laws and treaties. This EULA grants You no rights to use such 
content. Use of any on-line services which may be accessed through the SOFTWARE may be governed by the 
respective terms of use relating to such services. If this SOFTWARE contains documentation which is provided 
only in electronic form, You may print one copy of such electronic documentation.  You may not copy the printed 
materials accompanying the Hardware Device and SOFTWARE. All rights not specifically granted under this EULA 
are reserved by Microsoft and its suppliers. 

4. EXPORT RESTRICTIONS. You acknowledge that the SOFTWARE licensed under this EULA is subject to U.S. 
export jurisdiction. You agree to comply with all applicable international and national laws that apply to the 
SOFTWARE, including the U.S. Export Administration Regulations, as well as end-user, end-use and destination 
restrictions issued by U.S. and other government. For additional information see: 
http://www.microsoft.com/exporting/. 

GENERAL PROVISIONS 
These provisions 5, 6 and 7 apply to the Software Product License and the below Limited Warranty. 

5. EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN OTHER DAMAGES and LIMITATION OF 
LIABILITY. TO THE FULL EXTENT ALLOWED BY LAW, MICROSOFT IS NOT LIABLE FOR ANY: 

(i)CONSEQUENTIAL OR INCIDENTAL DAMAGES; 

(ii)DAMAGES OR LOSS OF ANY NATURE WHATSOEVER RELATING TO LOST PROFITS, LOSS OF DATA OR PRIVACY 
OR CONFIDENTIALITY, ANY INABILITY TO USE ALL OR PART OF THE HARDWARE DEVICE OR SOFTWARE, 
PERSONAL INJURY, OR ANY FAILURE TO MEET ANY DUTY (INCLUDING BUT NOT LIMITED TO ANY LACK OF 
NEGLIGENCE OR OF WORKMANLIKE EFFORT); OR 

(iii)INDIRECT, SPECIAL, OR PUNITIVE DAMAGES; 

ARISING OUT OF OR RELATING IN ANY WAY TO THE SOFTWARE OR HARDWARE DEVICE. THE FOREGOING APPLIES 
EVEN IF MICROSOFT OR ANY SUPPLIER OR AGENT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSSES OR 
DAMAGES; EVEN IN THE EVENT OF FAULT, TORT (INCLUDING NEGLIGENCE), STRICT OR PRODUCT LIABILITY, 
MISREPRESENTATION OR OTHER REASON; AND EVEN IF ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above 
limitation or exclusions may not apply to you.  
6. GOVERNING LAW. If You acquired the Hardware Device in the United States of America, the laws of the State 
of Washington, U.S.A., apply to this agreement. If You acquired the Hardware Device in Canada, except where 
expressly prohibited by local laws, the laws in force in the Province of Ontario, Canada apply to this agreement 
and each of the parties hereto irrevocably attorns to the jurisdiction of the courts of the Province of Ontario and 
further agrees to commence any litigation which may arise hereunder in the courts located in the Judicial District 
of York, Province of Ontario.  

If You acquired this Hardware Device outside of the countries listed above, then local laws may apply. 

7. QUESTIONS. Should You have any questions concerning this agreement, or if You desire to contact Microsoft 
for any reason, please use the address information enclosed in the Hardware Device to contact the Microsoft 
subsidiary serving Your country, or visit Microsoft on the World Wide Web at http://www.microsoft.com. 
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LIMITED WARRANTY 
A. WARRANTIES.  
Express Warranty. Subject to the terms and conditions of this Limited Warranty, Microsoft warrants that under 
normal use and service on the day You receive and for the next 90 days for the SOFTWARE and the next two (2) 
years for the Hardware Device (the “Warranty Period”), that the SOFTWARE and Hardware Device will 
substantially conform with the accompanying packaging and documentation.  

Implied Warranty. You may also have an implied warranty and/or condition under the laws of some jurisdictions, 
which is hereby limited to the duration of the Warranty Period. Some jurisdictions do not allow limitations on how 
long an implied warranty or condition lasts, so the foregoing limitation may not apply to you. 

As to any defects discovered after the Warranty Period, there is no warranty or condition of any kind. 

B. EXCLUSIVE REMEDY. During the Warranty Period and subject to applicable law, and provided that You either 
return the SOFTWARE and Hardware Device to Your place of purchase or to Microsoft with a copy of Your receipt 
or other bona fide proof of purchase, Microsoft will, at its option and as your exclusive remedy for breach of this 
Limited Warranty or any implied warranties: 

O repair or replace the defective SOFTWARE or the Hardware Device or 

O make payment to You for the allowable damages that You incur in reasonable reliance but only up to the 
amount of the price You paid for the SOFTWARE and the Hardware Device (if any). 

O Any replacement SOFTWARE or Hardware Device will be new or refurbished or serviceably used, comparable 
in function and performance to the original part or Hardware Device and warranted for the remainder of the 
original Warranty Period or 30 days from the date of shipment of the replacement back to You, whichever is 
longer. 

O Microsoft will use commercially reasonable efforts to diagnose and attempt to correct, or suggest solutions 
for, defects in the SOFTWARE and/or Hardware Device that are covered by this Limited Warranty. Microsoft 
does not provide any warranties regarding its warranty services and, except for the preceding sentence, 
disclaims all duties (if any) of workmanlike effort or of lack of negligence. 

O Except as otherwise required by legislation in Your jurisdiction, costs associated with transport (including 
packaging) for warranty service shall be at Your expense.  

C. NO OTHER WARRANTIES. The express warranty stated in Section A above is the only express warranty made 
to You and is provided in lieu of all other express or implied warranties and conditions (if any) including any 
created by any other documentation or packaging. No other warranties or conditions are made with respect to the 
SOFTWARE or Hardware Device or the warranty services by any person, including but not limited to Microsoft and 
its suppliers. No information (oral or written) or suggestions given by Microsoft, its agents or suppliers or its 
or their employees, shall create a warranty or condition or expand the scope of this Limited Warranty. Also, 
there is no warranty or condition of title, quiet enjoyment, or noninfringement in the SOFTWARE and Hardware 
Device. You may have greater rights existing under legislation in your jurisdiction. Where any term of this Limited 
Warranty is prohibited by such laws, it shall be null and void, but the remainder of the Limited Warranty shall 
remain in full force and effect. 

D. EXCLUSIONS. This Limited Warranty shall not apply and Microsoft has no liability under this Limited Warranty 
if the SOFTWARE or Hardware Device: 

O is used for commercial purposes (including rental or lease);  

O is modified or tampered with; 

O is damaged by Acts of God, power surge, misuse, abuse, negligence, accident, wear and tear, mishandling, 
misapplication, or other causes unrelated to defective materials or workmanship; 

O is damaged by programs, data, viruses, or files, or during shipments; 

O is not used in accordance with the accompanying documentation and use instructions; or 

O is repaired, modified or altered by other than Microsoft authorized repair centers. 

E. REGISTRATION. You need not register Your acquisition of the SOFTWARE and Hardware Device for the Limited 
Warranty to be effective.  

F. BENEFICIARY. To the extent allowed by applicable law, the Limited Warranty is only made to You, the first 
licensed user of the SOFTWARE and Hardware Device, and there are no third party beneficiaries of the Limited 
Warranty. It is not intended for and does not apply to anyone else (except as required by law), including anyone to 
whom You make any transfer as authorized in the EULA. 
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CONTRAT DE LICENCE UTILISATEUR FINAL POUR LOGICIEL 
MICROSOFT 
À IMPORTANT--LIRE ATTENTIVEMENT : Veuillez lire attentivement et vous assurez de comprendre la totalité des 
droits et des restrictions qui sont décrits dans le présent contrat de licence utilisateur final (« CLUF ») de 
Microsoft, qui comprend la licence d’utilisation du logiciel, les dispositions générales, la garantie limitée et la 
limite de responsabilité. On vous demandera de prendre connaissance des modalités du CLUF et d’indiquer votre 
acceptation ou votre refus de ces modalités. Le LOGICIEL ne s’installera pas sur votre ordinateur tant que vous 
n’aurez pas accepté les modalités du présent CLUF. Si vous cliquez sur le bouton « j’accepte » vous serez réputé 
avoir apposé votre signature et accepté les modalités du CLUF. 

NOTE :  Les modalités de ce CLUF en format papier qui pourrait accompagner le LOGICIEL et l’appareil Microsoft 
qui l’accompagne remplacent les modalités d’un CLUF à l’écran intégré au LOGICIEL. 

Le présent CLUF constitue un contrat entre vous (un particulier ou une entité juridique désigné dans le présent 
CLUF par « vous », « votre » et « vos ») et Microsoft Corporation et comprend la licence d’utilisation du logiciel pour 
la partie logiciel de l’appareil, ce qui comprend le logiciel qui l’accompagne, et pourrait comprendre des supports, 
des documents papier et des documents « en ligne » ou électroniques connexes (le « LOGICIEL »). Le présent CLUF 
est valide et accorde à l’utilisateur final des droits SEULEMENT si le logiciel est un véritable LOGICIEL Microsoft. 
Si vous installez, copiez ou autrement utilisez le logiciel, vous acceptez d’être lié par les modalités du présent 
CLUF. Si vous n’acceptez pas les modalités du présent CLUF, n’installez pas et n’utilisez pas le LOGICIEL. Dans ce 
dernier cas, vous devriez retourner le LOGICIEL et l’appareil Microsoft qui l’accompagne à Microsoft ou l’endroit 
où vous l’avez acheté afin d’obtenir un remboursement. 

LICENCE D’UTILISATION DU LOGICIEL 
Le LOGICIEL est protégé par les lois sur le droit d’auteur et les traités internationaux en matière de droit d’auteur, 
ainsi que par d’autres lois et traités en matière de propriété intellectuelle. Le LOGICIEL ne fait pas l’objet d’une 
vente, mais plutôt d’une licence d’utilisation.  

1. OCTROI DE LICENCE. Le présent CLUF vous accorde les droits suivants : 

O Installation et utilisation du logiciel. À moins de stipulation contraire dans le présent CLUF, vous ne pouvez 
installer, utiliser ou exécuter (« exécuter ») qu’un exemplaire du LOGICIEL sur un seul ordinateur, comme un poste 
de travail, un terminal ou un autre appareil numérique (un « poste de travail ») auquel l’appareil ci-joint est relié. 
Vous pouvez également exécuter un exemplaire du LOGICIEL sur un ordinateur ou d’autres appareils 
électroniques (chacun, un « ordinateur » et, collectivement, les « ordinateurs ») qui sont branchés au poste de 
travail ou mis en réseau avec le poste de travail ou mis en réseau avec le poste de travail au moyen de l’appareil.  

O Conservation de droits. Microsoft se réserve tous les droits qui ne vous sont pas expressément accordés 
dans le présent CLUF. 

2. DESCRIPTION DES AUTRES DROITS ET LIMITES.  
O Mises à niveau du système d’exploitation. Le LOGICIEL peut contenir des mises à niveau des composants 

système requis pour l’exécution adéquate du LOGICIEL. Les mises à niveau système en question vous sont 
fournies sous licence aux termes des modalités figurant dans votre licence d’utilisation du système 
d’exploitation, à moins qu’un contrat de licence utilisateur final distinct ne vous soit fourni avec les mises à 
niveau, auquel cas le contrat distinct en question régit votre utilisation des mises à niveau. 

O Plusieurs appareils. Si vous avez acheté plusieurs appareils, vous pouvez faire une copie du LOGICIEL pour 
chaque appareil que vous avez acheté et vous pouvez utiliser chaque copie de la façon décrite ci-dessus. 

O Limites visant l’ingénierie inverse, la décompilation et le désassemblage. Vous n’êtes pas autorisé à vous 
adonner à l’ingénierie inverse, la décompilation ou le désassemblage du LOGICIEL, sauf si une telle mesure 
est expressément autorisée par la loi applicable, sans égard à la présente limite. 

O Séparation des composants. Le LOGICIEL visé par la licence d’utilisation ne constitue qu’un seul produit. Ses 
composants ne peuvent pas être utilisés de façon distincte sur plus d’un ordinateur. 

O Location. Vous n’êtes pas autorisé à louer ou prêter le LOGICIEL. 

O Ordinateur unique. Le LOGICIEL et l’appareil qui l’accompagne font l’objet d’une licence d’utilisation à titre de produit 
unique intégré. Le LOGICIEL ne peut être utilisé qu’avec l’appareil de la façon décrite dans le présent CLUF. 

O Transfert du logiciel. Vous ne pouvez transférer de façon permanente la totalité de vos droits aux termes du 
présent CLUF que si vous transférez l’appareil et ne conservez aucune copie, vous transférez la totalité du 
LOGICIEL (y compris tous les composants, les supports et la documentation imprimée, les mises à niveau, le 
présent CLUF et, le cas échéant, le certificat d’authenticité) et l’appareil qui l’accompagne, et que le 
destinataire accepte les modalités du présent CLUF. Si la partie LOGICIEL constitue une mise à niveau, le 
transfert doit comprendre toutes les versions antérieures du LOGICIEL. 

O Revente interdite du logiciel. Si le LOGICIEL porte la mention « revente interdite » vous ne pourrez alors pas, 
malgré les autres articles du présent CLUF, revendre ou autrement transférer contre valeur le LOGICIEL. 

Mises à jour automatiques. Vous reconnaissez que Microsoft peut vérifier de façon automatique la version du 
LOGICIEL et/ou des composants que vous utilisez et peut fournir des mises à niveau et/ou des ajouts au 
LOGICIEL et/ou à ses composants qui seront téléchargés automatiquement au poste de travail et à tous les 
ordinateurs. Votre utilisation du LOGICIEL, y compris les mises à niveau et/ou les ajouts, sera régie par le présent 
CLUF.  
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O Résiliation. Sans porter préjudice à d’autres droits, Microsoft peut révoquer les droits que le présent CLUF 
vous confère si vous omettez de vous conformer aux modalités du présent CLUF. Dans ce cas, vous devrez 
détruire toutes les copies du LOGICIEL et la totalité de ses composants.  

O Marques de commerce. Le présent CLUF ne vous confère aucun droit à l’égard des marques de commerce 
ou des marques de service de Microsoft ou de ses fournisseurs. 

O Services de soutien. Microsoft peut vous fournir des services de soutien liés au LOGICIEL et/ou à l’appareil 
(les « services de soutien »). L’utilisation des services de soutien est régie par les politiques et les 
programmes de Microsoft décrits dans le guide de l’utilisateur, la documentation « en ligne » et/ou d’autres 
documents fournis par Microsoft. Les autres codes de logiciel qui vous sont fournis dans le cadre des 
services de soutien seront réputés faire partie du LOGICIEL et seront assujettis aux modalités du présent 
CLUF. Microsoft peut utiliser les renseignements d’ordre technique que vous lui fournissez dans le cadre des 
services de soutien à des fins commerciales, dont le soutien et le développement de produits. Microsoft 
n’utilisera pas ces renseignements de façon à vous identifier. 

O DROIT D’AUTEUR. Tous les titres de propriété et les droits de propriété intellectuelle visant le LOGICIEL 
(notamment les images, les photographies, les animations, les séquences vidéos, les séquences audio, la 
musique, le texte et les « applets » intégrés dans le LOGICIEL), les documents imprimés qui l’accompagnent et 
toutes les copies du LOGICIEL appartiennent à Microsoft ou à ses fournisseurs. Tous les titres de propriété et 
les droits de propriété intellectuelle visant le contenu qui ne figure pas dans le LOGICIEL mais qui est 
accessible par l’utilisation du LOGICIEL appartiennent au propriétaire du contenu visé et pourraient être 
protégés par les lois et traités applicables en matière de droit d’auteur ou par d’autres lois et traités en 
matière de propriété intellectuelle. Le présent CLUF ne vous confère aucun droit d’utilisation de ce contenu. 
L’utilisation de services en ligne auxquels le LOGICIEL permet l’accès pourrait être régi par les modalités 
d’utilisation respectives concernant ces services. Si le LOGICIEL renferme de la documentation qui n’est 
offerte que sous forme électronique, vous pouvez en imprimer un exemplaire. Vous n’êtes pas autorisé à 
copier les documents imprimés qui accompagnent l’appareil et le LOGICIEL. Microsoft et ses fournisseurs se 
réservent tous les droits qui ne sont pas expressément conférés par le présent CLUF. 

3. RESTRICTIONS VISANT L’EXPORTATION. Vous reconnaissez que le LOGICIEL faisant l’objet d’une licence 
d’utilisation aux termes du présent CLUF est assujetti aux règles des États-Unis en matière d’exportation. Vous 
acceptez de vous conformer à toutes les lois internationales et nationales applicables à l’égard du LOGICIEL, 
notamment aux règlements des États-Unis en matière d’administration des exportations ainsi qu’aux restrictions 
visant l’utilisateur final, l’utilisation et la destination imposées par le gouvernement américain et d’autres 
gouvernements. Pour de plus amples renseignements, veuillez consulter le site 
http://www.microsoft.com/exporting/. 

DISPOSITIONS GÉNÉRALES 
Les articles 5, 6 et 7 s’appliquent à la licence d’utilisation du logiciel et à la garantie limitée figurant ci-après. 

5. EXCLUSION DES DOMMAGES ACCESSOIRES, INDIRECTS ET DE CERTAINS AUTRES DOMMAGES et 
LIMITATION DE RESPONSABILITÉ. DANS LA MESURE MAXIMALE PERMISE PAR LA LOI, MICROSOFT N’EST EN 
AUCUN CAS RESPONSABLE : 

i) DES DOMMAGES ACCESSOIRES OU INDIRECTS; 

ii) DES DOMMAGES OU PERTES DE QUELQUE NATURE QUE CE SOIT RELATIVEMENT AU MANQUE À GAGNER, 
À LA PERTE DE DONNÉES OU À LA VIOLATION DE LA VIE PRIVÉE OU DE LA CONFIDENTIALITÉ, À TOUTE 
INCAPACITÉ D’UTILISER LA TOTALITÉ OU UNE PARTIE DE L’APPAREIL OU DU LOGICIEL, À TOUT PRÉJUDICE 
PERSONNEL OU À TOUT DÉFAUT DE S’ACQUITTER D’UN DEVOIR (NOTAMMENT L’ABSENCE DE NÉGLIGENCE OU 
LE RESPECT DES RÈGLES DE L’ART); 

iii) DES DOMMAGES INDIRECTS, SPÉCIAUX OU PUNITIFS; SE RAPPORTANT DE QUELQUE MANIÈRE QUE CE 
SOIT AU LOGICIEL OU À L’APPAREIL. LA DISPOSITION QUI PRÉCÈDE S’APPLIQUE MÊME SI MOCROSOFT OU TOUT 
FOURNISSEUR OU AGENT A ÉTÉ INFORMÉ DE LA POSSIBILITÉ DE CES PERTES OU DOMMAGES, MÊME EN CAS 
DE FAUTE, DE DÉLIT CIVIL (Y COMPRIS LA NÉGLIGENCE), DE RESPONSABILITÉ STRICTE OU DE RESPONSABILITÉ 
CIVILE DE PRODUITS, DE DÉCLARATION FAUSSE OU TROMPEUSE OU D’AUTRES RAISONS, ET MÊME SI TOUT 
RECOURS N’ATTEINT PAS SON BUT ESSENTIEL. Certains territoires ne permettent pas d’exclure ou de limiter les 
dommages indirects ou accessoires, de sorte que les limites ou exclusions ci-dessus peuvent ne pas s’appliquer 
à vous. 

6. LOI APPLICABLE. Si vous avez acquis l’appareil aux États-Unis d’Amérique, les lois de l’État de Washington, 
aux États-Unis, s’appliquent au présent contrat. Si vous avez acquis l’appareil au Canada, sauf si les lois locales 
l’interdisent expressément, les lois en vigueur dans la province d’Ontario, au Canada, s’appliquent au présent 
contrat et chacune des parties aux présentes reconnaît, de façon irrévocable, la compétence des tribunaux de la 
province d’Ontario et accepte de soumettre tout conflit pouvant découler des présentes aux tribunaux situés 
dans le district judiciaire de York, en Ontario. Si vous avez acquis l’appareil à l’extérieur des pays dont il est 
question ci-dessus, les lois locales pourraient alors s’appliquer. 

7. QUESTIONS. Pour de plus amples renseignements sur le présent contrat ou si vous souhaitez communiquer 
avec Microsoft pour quelque raison que ce soit, veuillez utiliser l’adresse figurant dans les documents qui 
accompagnent l’appareil pour communiquer avec la filiale de Microsoft qui dessert votre pays ou consulter le site 
Web de Microsoft à l’adresse http://www.microsoft.com. 
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GARANTIE LIMITÉE 
A. GARANTIES.  
Garantie expresse. Sous réserve des modalités de la présente garantie limitée, Microsoft garantit que dans des 
conditions normales d’utilisation et d’entretien pendant 90 jours à compter du jour où vous recevez le LOGICIEL 
et pendant deux (2) ans à compter du jour où vous recevez l’appareil (la « période de garantie »), le LOGICIEL et 
l’appareil répondront essentiellement aux caractéristiques qui figurent sur l’emballage et dans la documentation 
qui les accompagnent. 

Garantie implicite. Vous pourriez également bénéficier d’une garantie et/ou d’une condition implicite en vertu 
des lois de certains territoires, dont la durée est par la présente limitée à la période de garantie. Certains 
territoires n’autorisent pas la limitation de la durée d’une garantie ou condition implicite, de sorte que la limite 
ci-dessus peut ne pas s’appliquer à vous. 

En ce qui concerne les vices découverts après la période de garantie, aucune garantie ou condition de quelque 
nature que ce soit n’est offerte. 

B. RECOURS EXCLUSIF. Au cours de la période de garantie et sous réserve des lois applicables, et pourvu que 
vous retourniez le LOGICIEL et l’appareil à l’endroit où vous les avez achetés ou à Microsoft accompagnés d’une 
copie de votre reçu ou d’une autre preuve d’achat, Microsoft prendra, à son gré, l’une des mesures suivantes qui 
constituera votre recours exclusif en cas de violation de la présente garantie limitée ou de toute garantie 
implicite : 

O elle réparera ou remplacera un LOGICIEL ou un appareil défectueux; 

O elle vous versera une somme se limitant aux dommages admissibles raisonnables que vous avez subis, mais 
uniquement jusqu’à concurrence du prix que vous avez payé pour le LOGICIEL et l’appareil (le cas échéant); 

O le LOGICIEL ou l’appareil de rechange sera neuf ou remis à neuf ou d’occasion mais en état de fonctionner, 
offrant des fonctions et des performances comparables à la pièce ou à l’appareil d’origine et sera garanti 
pour le reste de la période de garantie initiale ou pendant 30 jours après la date d’expédition de la pièce ou 
de l’appareil de rechange qui vous a été retourné, selon le plus long de ces deux délais; 

O Microsoft déploiera des efforts raisonnables, sur le plan commercial, pour diagnostiquer et tenter de corriger 
les vices du LOGICIEL et/ou de l’appareil qui sont visés par la présente garantie limitée ou suggérer des 
solutions à leur égard. Microsoft n’offre aucune garantie relativement à ses services fournis aux termes de 
la garantie et, exception faite de la phrase qui précède, rejette toute obligation (le cas échéant) 
relativement au respect des règles de l’art ou à l’absence de négligence;  

O exception faite de ce qui est autrement prévu par les lois de votre territoire, vous devrez assumer les coûts 
associés au transport (y compris l’emballage) pour les services fournis aux termes de la garantie. 

C. AUCUNE AUTRE GARANTIE. La garantie expresse énoncée à la section A ci-dessus constitue l’unique garantie 
expresse qui vous est offerte et elle est fournie à la place de toute autre garantie et condition expresse ou 
implicite (le cas échéant) y compris une garantie et une condition figurant sur un autre document ou emballage. 
Aucune autre garantie ou condition n’est offerte à l’égard du LOGICIEL ou de l’appareil ou des services fournis 
aux termes de la garantie par quiconque, notamment à Microsoft et ses fournisseurs. Aucun renseignement 
(verbal ou écrit) ni suggestion donné par Microsoft, ses représentants ou fournisseurs ou leurs employés 
respectifs, ne doit créer une garantie ou une condition ou élargir la portée de la présente garantie limitée. De 
plus, aucune garantie ou condition n’est offerte à l’égard du titre de propriété, de la jouissance paisible ou de 
l’absence de contrefaçon du LOGICIEL et de l’appareil. Les lois de votre territoire pourraient vous conférer 
d’autres droits. Si l’une de ces lois interdit l’application d’une modalité de la présente garantie limitée, elle 
deviendra nulle et non avenue, mais le reste de la garantie limitée demeurera en vigueur. 

D. EXCLUSIONS. La présente garantie limitée ne s’appliquera pas et Microsoft n’aura aucune responsabilité aux 
termes de la présente garantie limitée si le LOGICIEL ou l’appareil : 

O est utilisé à des fins commerciales (y compris la locataion); 

O est modifié ou altéré; 

O est endommagé par suite d’un cas de force majeure, d’une surtension, d’une mauvaise utilisation, d’une 
négligence, d’un accident, d’une usure, d’une manipulation inadéquate ou d’une autre cause qui n’est pas 
liée à un vice de matériel ou de fabrication; 

O est endommagé par des programmes, des données, des virus, des fichiers ou pendant l’expédition; 

O n’est pas utilisé conformément à la documentation et aux directives d’utilisation qui l’accompagnent; 

O est réparé, modifié ou altéré ailleurs que dans un centre de réparation autorisé par Microsoft. 

E. ENREGISTREMENT. Vous n’êtes pas tenu d’enregistrer votre acquisition du LOGICIEL et de l’appareil pour que 
la garantie limitée entre en vigueur. 

F. BÉNÉFICIAIRE. Dans la mesure permise par la loi applicable, la garantie limitée n’est offerte qu’à vous, le 
premier utilisateur titulaire d’une licence d’utilisation du LOGICIEL et de l’appareil, et il n’existe aucun autre 
bénéficiaire de la garantie limitée. Elle ne vise personne d’autre et elle ne s’applique en faveur de personne 
d’autre (sauf stipulation contraire d’une loi), y compris toute personne à qui vous effectuez un transfert autorisé 
par le CLUF. 
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glossary 
 

This glossary contains common terms for wired and wireless networking. There is a 
more complete list of terms in Broadband Network Utility Help.  

 802.11b A wireless networking standard that transmits wireless data at 
speeds up to 11 megabits per second (Mbps).  

 802.11g A wireless networking standard that transmits wireless data at 
speeds up to 54 megabits per second (Mbps).  

 access point See “wireless access point.”  

 ad hoc network A wireless network in which computers connect to each other 
directly. Contrast with “infrastructure network.” 

 adapter See “network adapter.”   

 bandwidth The rate at which data can be transmitted through a network 
connection.  

 base station A device (also known as a gateway or router) that acts as a central 
point for networked devices, receiving and forwarding data between 
them. A base station typically is a point of connection that sends 
data between several networks. It often can be programmed with 
rules about what data is acceptable to send and receive. 

 bridge A networking device that exchanges data from one segment of a 
network to another. See “wireless access point.” 

 broadband  A high-speed Internet connection, typically 256 kilobits per second  
 connection (Kbps) or faster. Broadband services are usually provided over 

digital cable lines or digital telephone lines (DSL).  

 CardBus A credit card-sized device that is inserted into a slot on a computer, 
usually a notebook computer. 32-bit CardBus PC Cards look similar 
to the older 16-bit PC Cards, but are approximately four to six times 
faster and include a new power-saving design.  

 channel In reference to a “wireless channel,” a channel is a path or link 
through which information passes between two wireless devices. In 
radio transmission, these different channels are of different radio 
frequencies.  

 client A computer or software program that relies on another computer or 
program to act as a server. See “server.” 

 client/server  A network of two or more computers that rely on a central server to  
 network mediate the connections or provide additional system resources. 

Contrast with “computer-to-computer network.” 

 computer name A name that uniquely identifies a computer on a network. One 
computer name cannot be the same as any other computer name or 
domain name on the network. 
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 computer-to- A network configuration in which any computer can connect directly  
 computer network to any other computer on the network. Contrast with “client/server 

network.”  

 crossover cable See “Ethernet cable.” 

 DHCP Acronym for “Dynamic Host Configuration Protocol.” DHCP is an 
Internet protocol that automatically assigns temporary Internet 
Protocol (IP) addresses to computers.  

 DMZ See “virtual DMZ.” 

 DNS Acronym for “Domain Name System.” A data query service used on 
the Internet for translating host names, such as www.microsoft.com, 
into Internet addresses that can be understood by computers.  

 domain A collection of computers on a network that share a common user 
database and security policy. A domain is administered as a unit 
with common rules and procedures by the domain administrator. 
Each domain has a unique name.  

 DSL Acronym for “Digital Subscriber Line.” A constant, high-speed digital 
connection to the Internet that uses a dedicated telephone line. 

dynamic IP address A dynamic Internet Protocol (IP) address is a unique identifier that is 
assigned temporarily (by using the Dynamic Host Configuration 
Protocol, or DHCP) to a device that requires it. IP addresses are 
required for computers to find one another and communicate over 
the Internet. Contrast with “static IP address.”   

 Ethernet A networking standard that uses cables to transmit data between 
computers. Also known as the IEEE 802.3 standard.  

 Ethernet cable A type of cable that transmits data between computers. A widely 
used network technology. There are two types of Ethernet cables, 
straight-through and crossover, that differ in how the connectors on 
each end of the cable are wired. Ethernet cables can support speeds 
of 10 megabits per second (Mbps), 100 Mbps, and higher. 

 file sharing See “sharing.” 

 firewall A security system that helps protect a network from hacker attacks 
and other threats that originate outside the network. A hardware 
firewall is a device at the entrance to a network that has specific 
data-checking settings and that helps protect all of the devices 
connected to it. A software firewall resides on a single computer, 
helping to protect that computer from external threats. 

 firmware Software information loaded in permanent memory on a device. 

 gateway See “base station.”  

 host name The Domain Name System (DNS) name of a device on a network, a 
name such as www.microsoft.com.  
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 hub A device that has multiple ports and that serves as a connection 
point for Ethernet cables on a network. When data arrives at the hub 
from one computer, it is copied to the other ports to be transmitted 
to other computers. Unlike the more “intelligent” switch and router, 
the hub does not direct or control data flow.  

 infrastructure  A wireless network in which devices connect to each other through  
 network an access point, or use a more sophisticated intermediary such as a 

base station (gateway or router). Contrast with “ad hoc network.” 

 intranet A network within an organization, also called a private network, that 
is available only to certain people, such as employees of a company. 
Some intranets offer access to the Internet. 

 IP Acronym for “Internet Protocol.” The set of rules that describe how to 
send data between computers over the Internet. More specifically, 
this protocol governs the routing of data messages, which are 
transmitted in smaller components called packets. 

 IP address Acronym for “Internet Protocol” address. An IP address is an 
assigned number used to identify a computer that is connected to a 
network or the Internet through the Transmission Control 
Protocol/Internet Protocol (TCP/IP). An IP address consists of four 
numbers (each of which can be no greater than 255) separated by 
periods, such as 192.168.2.1. 

 ISP Acronym for “Internet service provider.” A company that provides 
access to the Internet. 

 Kbps Abbreviation of “kilobits per second.” A measure of data transfer 
speed through a modem or on a network.  

 LAN Acronym for “local area network.” A group of computers and other 
devices dispersed over a relatively limited area (for example, a 
building) and connected by a communications link that enables any 
device to interact with any other on the network. 

 MAC address Acronym for “media access control” address. Each network adapter 
and other network hardware device is manufactured with its own 
unique MAC address. Networking standards and technologies use 
MAC addresses to pass information between network devices.  

 Mbps Abbreviation of “megabits per second.” A measure of data transfer 
speed. Do not confuse with megabytes per second, or MBps.  

 NAT Acronym for “network address translation.” NAT is a base station 
feature and software feature that allows all of the computers on a 
network to access the Internet through one Internet Protocol (IP) 
address, and helps ensure the computers’ security by hiding their 
individual IP addresses. 

 network A group of computers and associated devices that are connected by 
communications paths. Networks can interconnect with other 
networks and contain sub-networks. A network can be permanent or 
temporary, small or large, and connect with cables and/or wirelessly. 
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 network adapter A computer circuit board, card, or other device used to provide 
network access from a computer to other parts of the network – for 
example, to another computer, a printer, or a base station (gateway 
or router). Adapters can be installed inside a computer, inserted into 
a computer’s expansion slots, or connected to a computer’s ports. 

 NIC Acronym for “Network Interface Card.” A circuit board, expansion 
card, or other device used to provide network access to a computer 
or other network component, such as a printer. Network interface 
cards do the actual sending and receiving of data. 

 packet A unit of information transmitted as a whole from one device to 
another on a network. This is often a piece of a file that has been 
divided up for efficient transmission over the Internet. 

 PC Card  A credit card-sized device that is inserted into a slot on a computer, 
usually a notebook computer.  

 PCI Acronym for “Peripheral Component Interconnect.” A specific local 
bus type that allows up to 10 PCI-compliant expansion cards to be 
installed in a computer. This architecture is designed to speed up 
system performance by allowing some expansion boards to 
communicate directly with the microprocessor. 

 PCMCIA Acronym for “Personal Computer Memory Card International 
Association.” This group defined the standards for the PC Card, a 
type of expansion card designed for notebook computers.  

peer-to-peer network A network of two or more computers that connect directly with one 
another. 

 Plug and Play Sometimes abbreviated “PnP.” A set of specifications that allow a 
computer to automatically detect and configure various peripheral 
devices, such as monitors, modems, and printers. See “UPnP.” 

 port This term has several meanings: (1) A physical connection through 
which data is transferred between a computer and another 
computer, a network, and other devices (such as a monitor, modem, 
or printer). (2) A software channel for network communications. 
When a client computer communicates through a network with a 
server, it sends its request over a certain numbered channel, called 
a “port.”  

 port forwarding When a base station, gateway, or router passes information between 
your network and the Internet, it filters the information based on 
which software (virtual) ports are being used and how those ports 
are configured. For example, Internet (HTTP) communication, by 
default, travels over port 80. To help ensure security, all other ports 
are blocked from transferring data unless you specifically configure 
those ports to “forward” incoming data to other locations.  

 PPP Acronym for “Point-to-Point Protocol.” A widely used data link 
protocol for transmitting data packets over dial-up telephone 
connections, such as between a computer and the Internet.  
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 PPPoE Acronym for “Point-to-Point Protocol over Ethernet.” A specification 
for connecting users on a network to the Internet by using a 
broadband connection (typically through a DSL modem).  

 protocol A set of rules and conventions for sending information over a 
network. These rules govern the content, format, timing, sequencing, 
and error control of messages exchanged among network devices. 
For example, your computer connects to the Internet using the 
Transmission Control Protocol/Internet Protocol (TCP/IP). 

 resource In reference to a “network resource,” a resource is any type of 
hardware (such as a modem or printer) or software (such as an 
application, file, or game) that users can share on a network.  

 router See “base station.” 

 server A computer or software program that mediates the connections 
between client computers or programs on a network. The server also 
responds to requests and provides shared resources, such as 
storage space or processing power, to clients on the network. 

 sharing To make the files, folders, or printers that are on one computer (or 
connected to one computer) available to other computers on a 
network. 

 SSID Acronym for “Service Set Identifier,” also known as a “wireless 
network name.” An SSID value uniquely identifies your wireless 
network and is case sensitive. 

 static IP address A static Internet Protocol (IP) address is a unique identifier that is 
assigned permanently to a computer by a network administrator or 
an Internet service provider (ISP). IP addresses are required in order 
for computers to find one another and communicate over the 
Internet. Contrast with “dynamic IP address.” 

 straight-through  See “Ethernet cable.”  
 cable   

 subnet A distinct network that forms part of a larger computer network. 
Subnets are connected through routers and can use a shared 
network address to connect to the Internet. 

 subnet mask Similar in form to an Internet Protocol (IP) address, a subnet mask is 
provided by your Internet service provider (ISP) and used to 
configure a networked computer for proper communication with a 
network. An example of a subnet mask value is 255.255.0.0. 

 switch Like a hub, a switch is a device that has multiple ports and that 
serves as a connection point for Ethernet cables on a network. But a 
switch only forwards data packets to the computer that has 
requested them. A router is a specialized kind of switch.  

 TCP/IP Acronym for “Transmission Control Protocol/Internet Protocol.” A 
networking protocol that allows computers to communicate across 
interconnected networks and the Internet. Every computer on the 
Internet communicates by using TCP/IP. 
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 UPnP UPnP™ standards are defined by the Universal Plug and Play Forum. 
They extend conventional Plug and Play (PnP) standards. When a 
UPnP device is plugged into a network, the other devices on the 
network automatically detect the new device. 

 USB Acronym for “universal serial bus.” A hardware standard for easily 
connecting peripherals to a computer system. USB supports Plug 
and Play and UPnP installation, so devices can be connected and 
disconnected without shutting down and restarting your computer. 

 USB port A rectangular slot in a computer or computer peripheral into which a 
USB connector is inserted. USB ports can be high-powered or low-
powered. USB ports that are connected directly to your computer are 
normally high-powered; USB ports that are on peripherals (such as a 
keyboard or monitor) are normally low-powered. Some USB devices, 
such as the Microsoft wireless adapter, require high-powered ports 
to function correctly. 

 virtual DMZ The Microsoft base stations support a variation of DMZ hosting 
capabilities, called a “virtual DMZ.” DMZ is an acronym for 
“demilitarized zone,” which refers to an area of your network that is 
outside of the firewall, and so is exposed to direct access from the 
Internet.  

 VPN Acronym for “virtual private network.” A set of computers on a public 
network, such as the Internet, that communicate among themselves 
by using encryption technology.  

 WAN Acronym for “wide area network.” A geographically widespread 
network that might include many linked local area networks (LANs). 

 WEP Acronym for “Wired Equivalent Privacy.” An encryption mechanism 
that helps protect data transmitted over wireless networks. If you 
are operating a wireless network, it is strongly recommended that 
you enable WEP. See “WPA.” 

 Wi-Fi Wi-Fi® is a popular term for certain wireless networks.  

 wireless access  A device that exchanges data wirelessly as an intermediary between  
 point computers on a network, especially between wireless and wired 

components of a network. An access point is not as sophisticated a 
device as a base station (gateway or router). See “base station.” 

 WLAN Acronym for “wireless local area network.” A network that exclusively 
relies on wireless technology for device connections.  

 workgroup A group of computers connected to each other over a network and 
sharing computer files, printers, and other resources. All computers 
on a network that wish to share resources must be members of the 
same workgroup. 

 WPA Acronym for “Wi-Fi Protected Access™.” A wireless security standard 
that improves upon its predecessor, Wired Equivalent Privacy (WEP), 
by providing stronger encryption, making a network harder to access 
without proper authentication. 
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file sharing, 35, 37 
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upgrading firmware, 24 

viruses, preventing, 24 
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joining, 22 
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settings, 10, 24 
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troubleshooting setup, 28 
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WPA (Wi-Fi Protected Access), 43 
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  Caution 
For use with UL Listed, CSA and GS approved personal computers. 

Not intended for use in machinery, medical or industrial applications. 

Do not use onboard an aircraft or in hazardous locations such as a gas station or other explosive 
environment. 

For indoor use only. 

Do not touch or re-orient the antenna while the device is transmitting 

Device should be located at least 5 cm (2 inches) away from any human body in order to meet FCC 
exposure limits.  Exposure time should be limited if the distance is less. 

  Avertissement 
N’utilisez qu’avec des composantes homologuées UL, CSA ou TUV. 

Ne pas utiliser ce dispositif dans une application industrielle ou médicale. 

Ne pas utiliser dans un avion ou en présence de vapeur explosive (station-service). 

N’utiliser qu’à l’intérieur. 

Ne touchez pas à l’antenne lorsque l’appareil est en fonction 

Autre composantes: Ce dispositif doit être à plus de 5 cm (2 pouces) de toute personne sinon l’utilisateur 
devrait limiter le temps d’exposition. 
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My Network Settings 
Use this page to record your network settings.  

Workgroup or domain name: ______________________________________  

Base Station password:  __________________________________________  
   (Default=admin) 

Wireless Settings 
Record the information used to configure a computer for wireless access to your 
network here. All computers accessing your network with a wireless connection 
need to use the same wireless settings. 

Wireless network name (SSID): ____________________________________  

WEP key or WPA passphrase: ______________________________________  

Wireless channel (ad-hoc networks only): ____________________________  

Wide Area Network Settings 
Complete this section only if your network has a base station (gateway or router). 
You can obtain this information from your Internet service provider (ISP). Your ISP 
may not require all of the settings listed below. 

Dynamic IP (DHCP) Settings 
Complete this section only if your ISP uses a DHCP connection. 

Host name: _____________________________________________________  

Adapter MAC address: ____________________________________________  

Static IP Address Settings 
Complete this section only if your ISP has assigned you a specific IP address. 

Static IP address: ________________________________________________  

Subnet mask: ___________________________________________________  

IP gateway address: ______________________________________________  

Primary DNS server: ______________________________________________  

Secondary DNS server: ___________________________________________  

PPPoE Settings 
Complete this section only if your ISP uses PPPoE. 

User name: _____________________________________________________  

Password: ______________________________________________________  

Service name: ___________________________________________________  
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